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Inleiding

Beste websitebouwer,

Gefeliciteerd! Je hebt besloten een website te maken met WordPress. Bij STRATO weten 
we hoe eenvoudig het is en we willen onze ervaring graag met je delen. Dankzij onze 
WordPress pakketten is het voor jou bijzonder gemakkelijk om te beginnen; met een paar 
klikken ben je klaar: 

Bestel hier je WordPress hostingpakket! 

Maar hoe begin je goed? Met deze gids willen we je helpen met de belangrijkste eerste 
stappen.	We	leggen	uit	hoe	je	WordPress	installeert	en	configureert,	bijdragen	en	pagina‘s	
maakt, afbeeldingen toevoegt, plug-ins gebruikt en wat je kunt doen om je website te 
beschermen tegen gevaren.

We	leiden	je	door	de	verschillende	stadia	aan	de	hand	van	een	fictief	blog	over	katten.	Dat	
hebben we opgezet met ons hostingpakket WordPress Hosting Starter. We gebruiken 
hiervoor	WordPress	versie	6.1.1.	Deze	gids	helpt	je	ook	als	je	een	andere	versie	of	een	
ander hostingpakket van STRATO gebruikt. Wel kunnen sommige details dan afwijken. 

Meer informatie vind je op het STRATO blog. Daar verschijnen regelmatig nieuwe artikelen 
over WordPress en het maken van websites. Je kunt daar ook contact met ons opnemen, 
vragen stellen of suggesties achterlaten. 

We wensen je veel leesplezier en succes met het maken van je website! 

STRATO team 

https://www.strato.nl/hosting/wordpress-hosting/
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1		 	WordPress	configureren

1.1		 Wat	je	nodig	hebt	om	je	website	te	beginnen

In principe kun je een website maken via een gratis dienst als Tumblr of wordpress.com. 
Maar je kunt ook aan de slag met een hostingpakket. Dit kost weinig geld en biedt twee 
grote	voordelen.	Ten	eerste	kun	je	het	ontwerp	en	de	functies	veel	flexibeler	aanpassen	
aan je eigen behoeften. Ten tweede worden je gegevens bij STRATO niet in het buitenland 
opgeslagen, maar uitsluitend in Europese datacenters. 

WordPress stelt diverse technische eisen aan het hostingpakket. Dankzij de automatische 
installatie bij STRATO zijn deze details niet zo belangrijk om het systeem te kunnen 
begrijpen. Wat telt, is dat de hostingpakketten van STRATO ruimschoots aan de eisen 
voldoen. 

Als je een ander hostingpakket kiest, moet je 
twee punten in overweging nemen: 

1. WordPress werkt alleen als er voldoende 
opslagruimte is. De webspace is de harde 
schijf van de server. Die moet dus groot 
genoeg zijn, zodat je al je content inclusief 
afbeeldingen kunt uploaden zolang je wilt. 
Teksten zijn geen probleem, die worden 
opgeslagen in de database en vergen 
uiterst weinig opslagruimte. Muziek en 
video‘s hebben ook geen webspace nodig 
als je ze integreert via externe diensten als 
Soundcloud of YouTube. Ook in het 
kleinste hostingpakket, STRATO 
WordPress Hosting Starter, heb je al 
genoeg ruimte voor duizenden 
afbeeldingen. 

2.  Je nieuwe website heeft ook een internetadres (domein) nodig, zoals  
https://kattenvereniging-limburg.nl. Elk domein is uniek, net als een postadres. 
Daardoor zijn veel populaire .nl-adressen al bezet. Met de introductie van nieuwe 
domeinextensies als .amsterdam, .shop of .photography kun je nog veel meer 
aantrekkelijke adressen registreren. Bij de STRATO hostingpakketten is altijd  
een domeinnaam inbegrepen. Kijk voor een overzicht van de beschikbare extensies 
op onze website.

WordPress is een prachtig systeem om het internet te voorzien 
van extra kattencontent of andere nuttige informatie. 

https://nl.wordpress.org/about/requirements/
https://www.strato.nl/hosting/wordpress-hosting/
https://www.strato.nl/hosting/wordpress-hosting/
https://www.strato.nl/hosting/wordpress-hosting/
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1.2		 Automatische	installatie	met	STRATO	

Met STRATO heb je de keuze om WordPress automatisch of handmatig te installeren. In 
de meeste gevallen wordt de automatische manier aanbevolen, omdat die veel 
gemakkelijker en sneller is. We leggen je hieronder uit hoe dit werkt. 

Uitzondering: je kunt niet om een handmatige installatie heen als je meerdere websites 
centraal wilt beheren door de WordPress Multisite-functie te gebruiken. In dat geval zijn 
de standaard hostingpakketten van STRATO precies goed voor jou. Daarmee heb je 
volledige controle en de optimale infrastructuur. Ook in deze pakketten heb je overigens 
de mogelijkheid om WordPress automatisch te installeren (Klantenlogin > Je pakket > 
Website-apps). 

 
Met STRATO WordPress Hosting Starter kun je WordPress zonder enige technische 
voorkennis installeren. WordPress wordt namelijk automatisch geïnstalleerd als je voor 
het	eerst	inlogt.	Allereerst	kun	je	kiezen	uit	twee	mogelijkheden:	de	flexibele	modus	en	de	
veilige modus. Wie vertrouwd is met WordPress en handmatig updates wil installeren, 
kiest het eerste. Onervaren WordPress gebruikers die gewoon snel aan de slag willen, 
kunnen beter de veilige modus kiezen. 

Stap	1:	kies	de	modus 

Je kunt kiezen uit twee mogelijkheden. 

WordPress Multisite: met deze optie kun je meerdere WordPress websites centraal 
beheren via één installatie. Om de functie te activeren, moet je WordPress handmatig 
installeren en enkele wijzigingen aanbrengen in de bestanden. Vanwege de complexiteit 
wordt Multisite alleen aanbevolen voor ervaren WordPress gebruikers die bekend zijn met 
PHP en die meerdere websites beheren.
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Stap 2: domein koppelen

In de volgende stap kies je een bestaand domein voor WordPress (bij- 
voorbeeld https://kattenvereniging-limburg.nl) in het dropdown-menu. Wil je  
dat de website toegankelijk is onder een zogenaamd subdomein (bijvoorbeeld  
https://blog.kattenvereniging-limburg.nl)? Dan kun je dat subdomein hier aanmaken. 

Stap 3: toegangsgegevens en titel instellen 

Registreer je als 
beheerder door je 
gebruikersnaam, 
wachtwoord en 
e-mailadres in te voeren. 
Als je niet zeker bent van 
de titel van de website, 
kun je die (evenals de 
toegangsgegevens) later 
in WordPress gemakkelijk 
wijzigen. Belangrijk: 
noteer je gebruikersnaam 
en wachtwoord. 

Je kunt kiezen uit de (sub)domeinen die in je pakket zijn opgenomen. 

Zodra je een (sub)domein hebt gekozen, kun je de toegangsgegevens  
en de titel van de website vastleggen. 

nicht erreichbar 
link

https://blog.kattenvereniging-limburg.nl/
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Tenslotte ontvang je de links naar de website en de admin-interface: 
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 En zo ziet je website er meteen na de installatie uit, als je klikt op de link Naar website:

SSL-versleuteling activeren 

Voordat je aan de slag gaat, moet je het domein omzetten naar https. SSL-encryptie  
is namelijk nodig voor een veilige gegevensoverdracht. Zie het als een verzegelde brief: 
derden kunnen hem niet lezen. Je regelt het in twee stappen: 

WordPress met de standaardlay-out
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1. Ga	naar	de	STRATO	klantenlogin	en	wijs	het	STRATO	SSL-certificaat	toe	aan	het	
WordPress domein (Domeinen > Domeinbeheer).

2. Klik op Versleutelen en in het volgende scherm op Inbegrepen certificaat 
gebruiken.	Daarna	kun	je	het	certificaat	toewijzen	aan	je	website.

Kies het domein waaronder je WordPress hebt geïnstalleerd. 

Kies het juiste  
certificaat.	
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3. Log vervolgens in op WordPress met je eerder toegewezen toegangsgegevens. 
Je hebt toegang tot het inloggedeelte via het domein plus de toevoeging  
/wp-admin (bijv. https:// kattenvereniging-limburg.nl/wp-admin). Aan de 
linkerkant onder Instellingen > Algemeen vul je bij de beide adressen gewoon 
achter http een s in. Zodra je de wijzigingen hebt opgeslagen, is WordPress 
alleen nog via een versleutelde https-verbinding toegankelijk.

Wijs	het	certificaat	toe	aan	je	website.

Na het omschakelen moet je opnieuw inloggen.



13STRATO | WordPress voor beginners

1.3		 WordPress	instellingen	aanpassen

Je ziet nog niet veel op je website, behalve het typische ‘Hello World‘ in de standaardlay-
out ofwel thema. Dat willen we veranderen. Hieronder laten we zien welke instellingen je 
hiertoe in WordPress moet doorvoeren. 

Eerst klik je op de link naar de admin-interface  
in de STRATO klantenlogin of voer je de link 
rechtstreeks in je browser in (domein + /wp-admin). 
Dit brengt je naar het inloggedeelte van je nieuwe 
website. Daar voer je de eerder geselecteerde 
toegangsgegevens	in	(zie	stap	1).

Na het inloggen kom je in het zogenaamde dashboard 
van je nieuwe website, een deel van de backend. Hier 
kun je alle WordPress instellingen doorvoeren.

Let op: als	je	tijdens	de	installatie	de	flexibiliteitsmodus	hebt	gekozen,	kunnen	er	een	of	
meer	updates	beschikbaar	zijn.	In	hoofdstuk	5.1.3	lees	je	hoe	je	ze	installeert.

Inloggedeelte van WordPress 

De backend is de (niet-openbare) admin-interface van WordPress met alle belangrijke instellingen. 
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1.3.1		 Paginatitel	en	ondertitel	

Alle basisinstellingen vind je in het menu-item Instellingen in de linker menubalk, 
helemaal onderaan. Onder Algemeen kun je de paginatitel aanpassen en een subtitel 
invoeren. Dit is een goede manier om de slogan van de website op te nemen (bijvoorbeeld 
‘Meer kattencontent!‘). Met een klik op Wijzigingen opslaan wordt de (publiekelijk 
zichtbare) website onmiddellijk bijgewerkt.

Algemene instellingen in de backend 
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1.3.2		 Permalinks

Onder Instellingen > Permalinks kun je de URL-structuur van onder meer je berichten, 
pagina‘s,	categorieën	en	tags	definiëren.	Dit	is	nodig,	want	in	de	standaardinstelling	zien	
de links er zo uit: 

https://kattenvereniging-limburg.nl/?p=123. 

Voor bijzonder eenvoudige, duidelijke links kun je het beste de optie Berichtnaam kiezen. 
Als een bericht bijvoorbeeld ‘Kitty jaagt op muizen‘ heet, maakt WordPress er de volgende 
URL van: https://kattenvereniging-limburg.nl/kitty-jaagt-op-muizen. Zulke links zijn 
herkenbaar en kunnen gemakkelijk met anderen gedeeld worden. In de bericht- of 
paginaweergave kun je de automatisch gegenereerde link eenvoudig aanpassen (kijk voor 
meer informatie bij ‘Berichten aanmaken‘).

1.3.3		 De	homepage	instellen

WordPress toont de laatste berichten in chronologische volgorde op de startpagina 
(homepage). Dit is vooral typisch voor blogs en praktisch voor lezers, omdat ze altijd de 
laatste berichten kunnen zien. 

Permalinks naar eigen inzicht
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Maar in sommige gevallen is een statische pagina interessanter. Bijvoorbeeld als het gaat 
om een website die niet zo vaak wordt bijgewerkt. Dit kan eenvoudig in de backend 
worden veranderd via Instellingen > Lezen. Omdat er nog geen pagina‘s gemaakt zijn, is 
momenteel alleen de voorbeeldpagina ‘Sample page‘ beschikbaar. In hoofdstuk 3 laten we 
je zien hoe je pagina‘s maakt in WordPress. Deze kunnen dan hier als startpagina worden 
geselecteerd.

1.3.4		 Zichtbaarheid	voor	zoekmachines

In hetzelfde menu vind je de opties voor zoekmachines. In de basisinstellingen  
indexeren Google en andere zoekmachines je website en tonen het in hun zoekresultaten. 
Als je de site in alle rust wilt opbouwen en geen bezoekers wilt hebben, kun je hier een 
vinkje zetten. Dit wordt aanbevolen zolang je nog geen imprint en privacybeleid hebt 
gemaakt (meer hierover in hoofdstuk 3). Zodra alles klaar is, moet je het vinkje weer 
verwijderen – anders vinden geïnteresseerden je website niet via een zoekmachine. 

Blog of traditonele website? De homepage kan de laatste berichten of een statische pagina weergeven.
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2   Lay-out en navigatie  
  aanpassen 
Het thema is het ontwerpsjabloon voor je WordPress website. In dit hoofdstuk laten we je 
zien hoe je jouw favoriete thema installeert en navigatiemenu‘s maakt in WordPress. 

2.1		 Thema‘s	installeren	en	aanpassen

Het is verrassend eenvoudig om de vormgeving van je WordPress website te veranderen, 
omdat WordPress tekst en vormgeving scheidt. Als je jouw site een nieuw uiterlijk wilt 
geven, hoef je niet elk bericht en elke pagina afzonderlijk aan te passen, maar verander je 
gewoon het ontwerpsjabloon, het ‘thema‘.  

Er zijn ook ontwikkelaars die zeer geavanceerde en veeleisende thema‘s ontwikkelen en 
verkopen. Voor dergelijke thema‘s ontvang je na aankoop een zip-bestand dat je 
handmatig via SFTP moet installeren. Maar maak je geen zorgen, ook dit is vrij eenvoudig. 

2.1.1	 Thema‘s	uit	de	WordPress	directory

Om een nieuw, gratis thema te vinden, klik je in het WordPress menu Weergave op 
Thema en dan op Nieuwe toevoegen.

Je kunt een nieuw thema direct vanuit WordPress toevoegen. 

Thema: WordPress ontwerpsjablonen worden thema‘s genoemd. Na de installatie van WordPress is 
automatisch het huidige standaardthema actief. Je kunt nog meer thema‘s uploaden via Weergave > 
Thema‘s en ze dan activeren. Handig is dat WordPress een uitgebreide directory met gratis thema‘s 
biedt. Daar kun je een thema naar wens kiezen. De thema‘s uit deze lijst kun je met een paar 
muisklikken gemakkelijk installeren en direct gebruiken. 
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Hier kun je door het aanbod van thema‘s bladeren en bijzonder populaire of nieuwe 
thema‘s bekijken. Er is ook een voorbeeldfunctie voor bijna alle thema‘s. 

De optie Eigenschapfilter is heel praktisch. Hier kun je zoeken naar thema‘s die 
bijvoorbeeld bepaalde kleuren gebruiken, een bepaald lay-outschema hebben of speciale 
functies bevatten.

2.1.2		 Een	thema	selecteren	en	installeren

Klik je op de voorbeeldafbeelding in het thema-overzicht (‘Details & Voorbeeld‘)? Dan zie je 
een preview in de volledige grootte. Dit voorbeeld bevat meestal gedetailleerde informatie 
over het thema en geeft je een indruk van hoe het thema er precies uitziet. 

Thema-preview met voorbeeldcontent 

Themadirectory	met	zoekfunctie	en	filteropties
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Heb je eenmaal een thema gevonden dat je 
bevalt? Klik dan gewoon op Installeren. We 
kiezen in dit voorbeeld het thema Twenty 
Twenty van het WordPress team. 

Maak je geen zorgen, je websitebezoekers zien 
nog niets. Na de installatie is het thema 
beschikbaar in je WordPress, maar nog niet 
actief. Je kunt zelf beslissen of je het thema 
meteen wilt activeren. Maar meestal is het 
zinvol om eerst op Live voorbeeld te klikken. 
Dan zie je een voorbeeld van je website in het 
nieuwe design.

2.1.3		 Een	alternatief	thema	handmatig	installeren

Je kunt ook buiten je WordPress 
backend thema‘s zoeken,  
namelijk via  
https://nl.wordpress.org/themes/, 
waar je het thema vervolgens als 
bestand kunt downloaden. Dit thema 
moet je dan wel handmatig 
installeren. Overigens geldt dit ook 
voor thema‘s die je van andere 
bronnen haalt, bijvoorbeeld als je een 
thema online koopt van een 
ontwikkelaar.

Als je een WordPress thema 
downloadt, krijg je meestal een zip-
bestand. Dit moet je eerst uitpakken 
op je harde schijf. In de map waarin je 
het zip-bestand hebt uitgepakt, staan 
vervolgens vaak veel bestanden in 
verschillende submappen.

Een thema downloaden uit de WordPress directory

Het Twenty Twenty-thema, uitgepakt  
op	de	lokale	harde	schijf	(Windows	10)	

Het thema is nu geïnstalleerd, maar nog niet actief. 

https://nl.wordpress.org/themes/
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Maak nu een SFTP-verbinding met je webspace bij STRATO, bijvoorbeeld met de gratis 
SFTP-client FileZilla. Kijk voor meer informatie ook eens in onze FAQ. Ga naar de submap 
van het WordPress thema in je webspace, meestal vind je deze map onder /WordPress/
wp-content/themes. 

Kopieer nu de complete themamap van je harde schijf via SFTP. In ons voorbeeld kopiëren 
we de map twentytwenty naar de map ‘themes‘. 

Nu is het nieuwe thema beschikbaar in WordPress. Je kunt op dezelfde manier te werk 
gaan als met een thema dat je rechtstreeks uit de WordPress directory hebt geselecteerd. 
Het thema dat je zojuist hebt geüpload, verschijnt nu ook onder Weergave > Thema‘s. 

2.1.4		 Het	thema	aanpassen

In de live preview van het themaoverzicht 
onder Weergave > Thema‘s kun je 
desgewenst eigen aanpassingen 
doorvoeren voordat je het thema activeert. 
Bijvoorbeeld je eigen logo uploaden, de 
kleuren veranderen of de menu‘s 
aanpassen. Klik gewoon op de 
desbetreffende	optie	in	de	menubalk	links.

Kopieer de complete map met de bestanden van het nieuwe thema naar de map themes van je  
WordPress installatie op je webspace. 

In de linker menubalk biedt het thema diverse  
uitgebreide	configuratiemogelijkheden.	

https://www.strato.nl/faq/hosting/zo-maak-je-verbinding-met-de-sftp-server/
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Let op: niet elk thema heeft dezelfde functies. Bij sommige kun je alleen je eigen logo 
integreren en een paar kleuren aanpassen, andere hebben een enorm menu vol 
aanpassingsmogelijkheden. 

Steeds weer kom je thema‘s tegen die in de gratis versie relatief weinig aanpassingen 
toestaan, maar in een betaalde pro-versie veel opties bieden. In deze gevallen kun je eerst 
de gratis versie testen en dan pas besluiten of je de professionele versie koopt. Want als je 
met de opties in de gratis versie tevreden bent, houd je die gewoon. 

Met de live preview kun je meteen zien hoe je website eruit ziet na elke verandering.  
Je kunt op je gemak verschillende wijzigingen uitproberen tot je precies de instellingen 
hebt gevonden die voor jou ideaal zijn. 

Merk je juist dat het thema er spannender uitzag dan het in werkelijkheid is? Klik in dat 
geval gewoon op het kruisje linksboven om de preview te sluiten. Zoek vervolgens een 
ander thema. 

Het Twenty Twenty-thema biedt de mogelijkheid om de navigatie-menubalk aan te passen via de thema-opties. 
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Activeren en publiceren 

Heb je jouw nieuwe thema aangepast met de opties, bijvoorbeeld je kleurenschema 
ingesteld, header- en achtergrondafbeeldingen geüpload en widgets geselecteerd? Dan 
komt het spannende moment: klik op Activeren & publiceren om live te gaan met je 
nieuwe thema. Nu zien ook je bezoekers het nieuwe design. 

Als je later merkt dat je liever bij je oude thema was gebleven of tóch nog een paar andere 
thema‘s wilt uitproberen, is dat geen probleem. Ga in het WordPress menu onder 
Weergave naar Thema‘s. Klik onder je oude thema op Activeren en je website ziet er 
weer uit als voorheen.

2.2 Navigatiemenu‘s 

Naast pagina‘s en berichten is een goede navigatie op een WordPress website absoluut 
onmisbaar. We laten je stap voor stap zien hoe je navigatiemenu‘s maakt in WordPress en 
ze in je website integreert.

Menu‘s helpen je lezers de weg te vinden op je site. Met een goede navigatiestructuur kun 
je ervoor zorgen dat zelfs toevallige bezoekers meer dan één bericht lezen of pagina 
bezoeken. Vaste lezers kunnen bovendien oudere berichten gemakkelijker terugvinden. 
Een gebruiksvriendelijk en duidelijk gestructureerd navigatiemenu is daarom essentieel 
voor elke website. 

2.2.1		 WordPress	begrijpen:	zo	werken	menu‘s

Als	je	menu‘s	wilt	maken,	geeft	WordPress	je	veel	flexibiliteit.	Maar	eerst	heb	je	wat	
basiskennis nodig van de werking van menu‘s in WordPress. WordPress handelt drie 
dingen volledig afzonderlijk af: 

• de tekstcontent van de menu‘s (de afzonderlijke menu-items en hun volgorde)

• de positie van een navigatiemenu op je website

• het visuele ontwerp van de menu‘s (lettergrootte, kleur, enzovoort)

Alle	drie	aspecten	kun	je	onafhankelijk	van	elkaar	configureren.	Je	moet	wél	de	teksten	
zelf invoeren. Het ontwerp van de menu‘s en de positie zijn al standaard in je thema 
ingesteld, maar je kunt beide zaken naar wens aanpassen.

Menu: een menu helpt je lezers hun weg te vinden op je website. De meeste belangrijke pagina‘s en 
categorieën zijn hier gelinkt. Om een nieuw menu te maken, klik je op maak een nieuw menu 
onder Weergave > Menu‘s. Sommige thema‘s ondersteunen meerdere menu‘s, zodat je zelf kunt 
bepalen waar ieder menu wordt weergegeven (zie het tabblad Locaties beheren).
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2.2.2		 Stap	1:	menu-content	maken

In principe kun je in WordPress zoveel verschillende navigatiemenu‘s maken als je wilt.  
Die kun je vervolgens op je website plaatsen. Extra menu‘s kunnen de hoofdnavigatie 
aanvullen en handig zijn om bijvoorbeeld de footer of een ander deel van je website 
verder te structureren. In de eerste stap maken we een enkel menu, zodat we dan iets 
hebben wat we kunnen plaatsen. 

Om een nieuw menu aan te maken, klik je onder Weergave > Menu‘s op maak een 
nieuw menu. Is er al een menu in je thema geïnstalleerd? Dan kun je deze stap overslaan 
en het bestaande menu bewerken. 

Geef het nieuwe menu 
een duidelijke naam, 
zodat je weet welk 
menu je kiest als je 
meerdere menu‘s 
hebt. Klik vervolgens 
op Menu aanmaken. 

WordPress biedt je 
verschillende 
mogelijkheden om 
nieuwe menu-items 
toe te voegen. Dit zijn 
bijvoorbeeld 
individuele pagina‘s, 
berichten, links naar 
categorieën of links die 
je geheel vrij bepaalt. 

Een nieuw navigatiemenu aanmaken

WordPress biedt verschillende elementen om in je menu in te voegen.
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Wil je bijvoorbeeld een bestaand WordPress bericht aan het menu toevoegen? Klik dan op 
Berichten, plaats een vinkje voor het gewenste bericht in de lijst en klik op Aan menu 
toevoegen. Herhaal dit nu voor alle menu-items die opgenomen moeten worden. 
Natuurlijk werkt dit ook met pagina‘s of categorieën. 

Onder Menu-instellingen kun je ook het vakje Automatisch pagina‘s toevoegen 
aanvinken. Dan past WordPress automatisch je menu aan als je een nieuwe pagina (niet: 
bericht) in WordPress maakt.

Bijzonder is de optie Aangepaste links. In plaats van te kiezen uit bestaande  
berichten,	kun	je	hier	links	als	menu-items	definiëren.	Dit	kunnen	ook	links	buiten	je	 
eigen website zijn. Vul onder Aangepaste links de URL van de link in (bijvoorbeeld:  
www.dierenbescherming.nl) en de tekst die in het menu moet worden weergegeven als 
linktekst (in het voorbeeld: ‘Dierenbescherming Amsterdam‘). Klik dan zoals gewoonlijk op 
Aan menu toevoegen. Let op: tot slot moet je altijd Menu opslaan aanklikken, anders 
worden je wijzigingen niet toegepast. Afhankelijk van hoe uitgebreid je menu is geworden, 
kan het opslaan enige tijd duren – dit is normaal. 

De menu-items sorteren 

Als je de volgorde of hiërarchie van de menu-items wilt veranderen, kun je dat gemakkelijk 
doen door ze te verplaatsen met de muis. Klik op het onderdeel dat je wilt verplaatsen en 
houd de muisknop ingedrukt. Sleep het voorwerp naar zijn nieuwe positie en laat de 
muisknop los. Klik tenslotte op Menu opslaan.

De reeds toegevoegde menu-items zie je rechts onder ‘Menustructuur‘. 
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Op dezelfde manier kun je de hiërarchie in het menu veranderen, dus sommige pagina‘s 
onder andere pagina‘s zetten. Deze worden dan weergegeven in een submenu. Sleep een 
menu-item een beetje naar rechts en laat het daar los. Je ziet dan dat het menu-item 
automatisch een sub-item wordt van dat andere item.

Probeer zelf maar eens uit of het design van je thema voorziet in zulke submenu‘s en ze 
kan weergeven. Zo niet, zie je de sub-items van het menu niet terug op je website. 
Hierover later meer. 

Expertfuncties 

WordPress probeert het beheer van menu‘s zo eenvoudig mogelijk te houden. Als je meer 
functies wilt gebruiken, kun je extra opties activeren. Klik hiervoor rechtsboven op 
Schermopties. Als je een vinkje zet voor de extra opties, verschijnen ze naast de 
afzonderlijke menu-items.

Je kunt de volgorde van de menu-items veranderen door ze te verslepen, maar je kunt ook 
individuele items ondergeschikt maken aan andere in de hiërarchie. 
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Zo kun je bijvoorbeeld links in een 
nieuw venster openen voor 
afzonderlijke menu-items of het 
titelattribuut	definiëren.

Extra opties zijn beschikbaar via ‘Schermopties‘. 

De uitgebreide opties voor menu-items zijn  
direct beschikbaar als je rechtsboven in de  

WordPress weergave via ‘Schermopties‘ het  
betreffende	vakje	aanvinkt.	
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2.2.3  Stap 2: menu‘s op de website plaatsen

Nadat je het nieuwe menu hebt gevuld met content, is de volgende stap om het menu 
zichtbaar te maken op je website. Er zijn in principe twee manieren om dit te doen: 

• op	een	door	het	thema	aangegeven	plaats	(alle	thema‘s	definiëren	ten	minste	
één zo‘n menugebied) 

• met de standaardwidget ‘Individueel menu‘ op een willekeurige plaats binnen 
de widgetgebieden van je thema, bijvoorbeeld in een sidebar of voettekst. 

De menuposities instellen

Hoe krijg je het zojuist gemaakte menu op de juiste plaats? De eenvoudigste manier om 
dit te doen is via het tabblad Locaties beheren onder Weergave > Menu‘s. Daar staan 
de	door	het	thema	gedefinieerde	menuposities.	In	ons	voorbeeld	zijn	dit	het	Desktop	
horizontaal menu en het Footer menu. Selecteer in de keuzelijst ernaast het menu dat je 
zojuist hebt gemaakt en klik op Wijzigingen opslaan.

Hier wijs je jouw menu toe aan een positie die het thema bepaalt. 

Widgets: deze breiden je WordPress uit met extra functies die je kunt invoegen in bepaalde delen 
van je thema. Standaard widgets kunnen bijvoorbeeld gebruikt worden om menu‘s, categorieën, 
recente reacties en de zoekfunctie te plaatsen. Veel plug-ins hebben ook hun eigen widgets aan 
boord. Alle widgets, instellingen en beschikbare gebieden vind je onder Weergave > Widgets. 
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Als je de door het thema opgegeven menuposities niet wilt gebruiken, laat je de instelling 
voor de ongebruikte menuposities gewoon op de standaardinstelling Een menu 
selecteren staan. Dan wordt op deze positie niets weergegeven. 

Alle veranderingen die je hier doorvoert, kun je ongedaan maken met nieuwe instellingen. 
Je hoeft dus alleen maar een beetje te experimenteren om de beste oplossing voor je 
website te vinden.

Een menu insluiten in een widget 

Je	kunt	elk	menu	ook	weergeven	in	een	widgetgebied	dat	in	het	thema	is	gedefinieerd.	
Hiervoor biedt WordPress het standaardwidget ‘Navigatiemenu‘ in Weergave > Widgets. 
Sleep het widget gewoon naar het gewenste widgetgebied van je thema (in het voorbeeld: 
Footer). 

Geef het footerwidget een titel of laat dit veld leeg als het menu geen titel hoeft te krijgen. 
Kies daaronder het menu dat je wilt weergeven. Opslaan, klaar. 

De grondbeginselen van het integreren van elementen in widgetgebieden vind je in 
hoofdstuk 2.3. 

Het widget ‘Navigatiemenu‘ toont menu‘s in widgetgebieden. 
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2.2.4  Stap 3: het menu visueel vormgeven

Zoals	gezegd	configureert	WordPress	het	visuele	design	van	de	menu‘s	onafhankelijk	van	
de positie en content. Elk thema bevat al de juiste opmaak voor de geplande menu‘s. Hier 
hoef je dus eigenlijk niets te doen. 

Wil je toch het uiterlijk van de menu‘s veranderen? Neem dan eerst een kijkje in de 
configuratieopties	van	je	thema.	Daar	kun	je	soms	de	kleuren	of	de	hiërarchiediepte	van	
de menu‘s veranderen. Je vindt deze opties onder Weergave > Customizer of in speciale 
optiemenu‘s van je thema. Deze optiemenu‘s zijn meestal te vinden als sub-item van 
Weergave, maar dit hangt af van het thema dat je gebruikt. Gratis thema‘s bieden 
meestal	slechts	weinig	of	geen	configuratiemogelijkheden.	

2.2.5  Complexe menu‘s via plug-in

Een andere manier om navigatiemenu‘s mooier te maken zonder zelf te programmeren is 
het gebruik van geschikte plug-ins. Heb je menu‘s nodig met twee of drie subniveaus? Dan 
haal je vaak betere resultaten met een goede plug-in dan met de standaardtools van 
WordPress. Dat geldt zeker als het thema dat je gebruikt zulke menu‘s niet uitgebreid 
ondersteunt. 

Maar je moet het gebruik van een plug-in goed overwegen, vooral voor zo‘n essentieel 
onderdeel als de navigatie van de website. Als de plug-in op een dag niet meer werkt, 
bijvoorbeeld omdat de ontwikkelaar geen updates meer levert, heb je meteen een groot 
probleem op je site. Bovendien zijn echt goede plug-ins meestal niet gratis. 

Als WordPress beginner kun je daarom beter werken met de functies van WordPress en  
je thema. Een heel goede, maar ook vrij complexe plug-in is bijvoorbeeld UberMenu, dat 
29 dollar kost. 

Je maakt complexe navigatiemenu‘s gemakkelijk met plug-ins als UberMenu. 



30STRATO | WordPress voor beginners

2.2.6  Kies een thema met goede ondersteuning voor menu‘s

Verwacht je dat jouw navigatiemenu‘s complexer en uitgebreider worden? Dan moet je 
vanaf het begin een thema kiezen dat daarvoor geschikt is. Niet alle thema‘s hechten veel 
waarde aan goed functionerende navigatiemenu‘s. Met het verkeerde thema loop je dan 
dus vast. 

Maar hoe kies je het juiste thema? Let erop dat de menuposities in het thema 
overeenkomen met je ideeën. Kijk ook kritisch naar de visuele vormgeving van de menu‘s 
en kies een thema dat menu‘s met minstens twee hiërarchieniveaus ondersteunt. Je kunt 
dan namelijk met submenu‘s werken. 

2.3  Eigen content met widgets

Een bijzonder onderdeel in elk WordPress thema zijn de widgetgebieden. Dit zijn 
standaardgebieden in de lay-out die gewoonlijk op elke pagina van de website worden 
weergegeven. Voorbeelden zijn één of twee kolommen aan de linker- of rechterkant van 
je site, of vakken onder berichten. Kortom: alles wat je naast of onder de berichten of 
pagina‘s op je website ziet. 

Je kunt verschillende individuele widgets binnen een widgetgebied plaatsen. Dit zijn niet 
meer	dan	kleine	modules	met	definieerbare	content.	Een	widget	toont	bijvoorbeeld	de	
drie meest recente reacties, willekeurig gekozen foto‘s, een eenvoudig zoekformulier of 
een kalender om oudere berichten te vinden. 

Kant-en-klare widgets zitten soms in je 
thema. Je kunt ze ook via een plug-in 
installeren. De widgetgebieden vormen 
een essentieel onderdeel van het 
visuele ontwerp en verschillen sterk per 
thema. Sommige thema‘s hebben 
slechts één widgetgebied, andere 
bieden er meerdere, tot een bijna 
onbeheersbare hoeveelheid. 

In de volgende twee voorbeelden zijn 
de widgetgebieden van verschillende 
thema‘s te zien. De voorbeelden tonen 
je hoe verschillende widgets de indeling 
van een thema bepalen: Thema Twenty Sixteen met vier widgets rechts van het bericht. 
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Na het installeren van een thema moet je ook deze widgetgebieden naar wens inrichten, 
ofwel vullen met content. Het thema Twenty Twenty dat we gebruiken, heeft 
widgetgebieden in de footer. 

2.3.1		 Widgets	toewijzen	aan	een	widgetgebied

Om widgets in te stellen, ga je naar het menu Weergave en kies je het sub-item Widgets. 

Open vervolgens het widget, druk op het +-symbool en voeg het gewenste widget toe. 
Daarna	kun	je	het	widget	nog	naar	wens	configureren.	Vanaf	dit	moment	is	het	widget	
onmiddellijk zichtbaar voor je bezoekers. Probeer gewoon de bestaande widgets uit om te 
ontdekken wat ze precies doen en welke je wilt gebruiken.  
Overigens kun je widgets net zo gemakkelijk verwijderen als je ze in WordPress instelt. Als 
het	betreffende	widget	niet	in	uitgeklapte	toestand	wordt	weergegeven,	klik	je	erop	en	
druk je op Delete. 

2.3.2  Widgets instellen

De	meeste	widgets	moeten	nog	geconfigureerd	worden.	Je	moet	dan	bijvoorbeeld	een	
kop invoeren. Veel widgets hebben ook opties die je met een vinkje kunt activeren of 
deactiveren, of waarbij je een bepaalde waarde moet invoeren. Als voorbeeld nemen we 
een widget voor het weergeven van de meest recente commentaren. Daarbij heeft deze 
optie betrekking op het maximum aantal weer te geven commentaren. Klik op Update om 
de	configuratie	te	voltooien.	

2.3.3  De volgorde veranderen, widgets verplaatsen of deactiveren

Je kunt de volgorde van de widgets in een gebied veranderen door ze eenvoudigweg te 
verslepen. Zo verplaats je ook een widget van het ene gebied naar het andere.  
Als	je	een	widget	tijdelijk	niet	wilt	gebruiken,	maar	de	content	of	de	configuratie	niet	
helemaal wilt verwijderen, kun je het widget verplaatsen naar het gebied Inactieve 
widgets (linksonder). Daar kun je de widgets op elk moment weer activeren zonder dat je 
instellingen en content opnieuw hoeft aan te maken.   

Thema Twenty Twenty met widgets onder de pagina. 
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3  Content maken en  
  commentaren modereren
Als	je	website	eenmaal	is	geconfigureerd,	wordt	het	echt	leuk.	In	dit	hoofdstuk	laten	we	je	
zien hoe je op je WordPress website content maakt en reacties modereert. 

3.1	 Berichten	aanmaken

WordPress maakt onderscheid tussen berichten en pagina‘s. De laatste zijn bedoeld voor 
content die zelden of nooit verandert, bijvoorbeeld een contactpagina of een over ons-
pagina. Voor actuele content, zoals blogartikelen, gebruik je berichten. 

Je maakt berichten en pagina‘s via de editor. De editor toont elke paragraaf, afbeelding of 
video als een ‘blok‘ content. Elk blok heeft zijn eigen menu, bijvoorbeeld om kleuren, 
breedte en uitlijning aan te passen. Deze blokmenu‘s worden automatisch getoond en 
verborgen als je een blok selecteert. De blokken bevinden zich in de blokkenbibliotheek.  
Je kunt die op verschillende plaatsen oproepen door op het ‘+‘-symbool te klikken. Met de 
zoekfunctie of de lijst van meest gebruikte blokken kun je snel het juiste blok vinden. 

Wil je een nieuw bericht aanmaken? Dat doe je in het Dashboard via Berichten > Nieuw 
bericht. Vul in de titelbalk de titel van het bericht in en plaats de tekst eronder. Gebruik 
de entertoets om het blok ‘Paragraaf‘ er standaard onder te zetten. Heb je alle blokken en 
content geplaatst? Dan klik je rechtsboven op de knop Publiceren. Met de standaard 
ingeschakelde controle kun je tot slot nog de zichtbaarheid en het tijdstip van publicatie 
aanpassen. 

Editor: de titelbalk staat bovenaan, de blokken staan eronder. 
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3.1.1	 Overzicht	op	de	startpagina	met	het	blok	‘meer‘

Met het blok ‘lees meer‘ kun je bepalen welk deel van de tekst na publicatie op de 
overzichtspagina van je blog wordt weergegeven. Het artikel wordt dan op dit punt 
afgesneden. Bezoekers kunnen het hele artikel bekijken via een knop of link ‘lees meer‘. 
Dit maakt de overzichtspagina overzichtelijker. 

3.1.2	 Permalinks	wijzigen	voor	individuele	URL‘s

Na de eerste keer opslaan verschijnt de permalink aan de rechterkant onder het tabblad 
URL. Deze permalink wordt gebruikt om het bericht te openen nadat het is gepubliceerd. 
Als je ‘Berichtnaam‘ als URL-structuur hebt gekozen (Instellingen > Permalinks), kun je 
de URL op elk moment wijzigen. WordPress maakt automatisch een redirect van de oude 
URL naar de nieuwe. Interne en externe links (van andere websites) naar de post worden 
dus altijd doorgestuurd naar het juiste adres. 

3.1.3	 Afbeeldingen	voor	berichten:	geen	tekst,	maar	foto’s

Lezers vinden blogberichten 
met plaatjes meestal mooier 
dan alleen tekst. Vooral als 
het om kattenfoto‘s gaat, 
natuurlijk! Om de kattenfoto 
uit ons eerste hoofdstuk toe 
te voegen, gebruiken we de 
functie Uitgelichte 
afbeelding. Die vind je in de 
balk rechts.

Het Twenty Twenty-thema toont het blok ‘lees meer‘ op de startpagina als lees-meer-knop.
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Tijdens de volgende stap hebben we twee mogelijkheden. We kunnen de foto uploaden óf 
we kiezen er een uit de mediabibliotheek. In de mediabibliotheek slaat WordPress alle 
media op die al zijn geüpload. Omdat we nog niets hebben gepubliceerd, is onze 
mediabibliotheek momenteel leeg. We moeten dus eerst een foto uploaden. Aan de 
rechterkant voeren we een titel, een afbeeldingsomschrijving en de alternatieve tekst in. 
Een geschikte titel verhoogt de zichtbaarheid in zoekmachines, het onderschrift dient als 
extra informatie voor de lezers. De alternatieve tekst wordt weergegeven als de afbeelding 
niet geladen kan worden. Nog belangrijker: mensen met een visuele beperking gebruiken 
alternatieve teksten via hun schermlezer. Ze zijn dus een voorwaarde voor barrièrevrij 
webdesign. 

Met één klik op Uitgelichte afbeelding kiezen voorzien we het bericht van een illustratie. 
WordPress past de breedte van de afbeelding automatisch aan de juiste grootte aan. 
Welke afmetingen dat zijn, hangt af van het gebruikte thema en de media-instellingen.

3.1.4		 Afbeeldingen	bewerken:	wat	niet	past,	wordt	passend	
gemaakt

Onze voorbeeldfoto is bijna vierkant. In de meeste gevallen is een liggend formaat de 
betere keuze. Om dit te veranderen, klik je eerst op de afbeelding rechts van de editor en 
dan in de mediabibliotheek op de knop Afbeelding bewerken. Nu kun je met de muis 
een	gebied	van	de	afbeelding	selecteren	en	dat	uitsnijden	met	de	desbetreffende	tool.	Je	
bevestigt de selectie met de enter-toets, slaat het geheel op en klikt opnieuw op de knop 
Uitgelichte afbeelding kiezen. Overigens blijft de oorspronkelijke afbeelding behouden. 
WordPress maakt voor elke variant namelijk een apart bestand aan.

Na het uploaden komt de afbeelding automatisch in de mediabibliotheek terecht  
en kan ook in andere berichten of pagina‘s worden gebruikt. 
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3.1.5	 Afbeeldingen	toevoegen:	we	willen	katten	zien

Je kunt ook afbeeldingen invoegen binnen de hoofdtekst. Ga daarvoor in de editor op de 
gewenste plek naar de blokbibliotheek (‘+‘-symbool) en kies het blok ‘Afbeelding‘. Hier heb 
je de keuze om een nieuwe foto te uploaden of eentje uit de mediabibliotheek te nemen. 
De grootte wordt automatisch aangepast als je de afbeelding invoegt, zodat hij in het 
contentgebied past. De omvang van dat contentgebied hangt weer af van het thema dat je 
gebruikt. 

Vervolgens kun je de afbeelding uitlijnen met het blokmenu en onderaan een bijschrift 
invoeren. 

Afbeelding bewerken in WordPress: knippen, draaien, schalen? Geen probleem!

Het menu wordt geopend als het blok wordt geselecteerd. Je kunt de afbeelding bijvoor-
beeld links uitlijnen met de knop in het menu. 
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3.1.6	 Categorieën	aanmaken	en	toewijzen

Nu moet je het bericht aan een categorie toewijzen. Die categorieën worden vaak via links 
in de navigatie van je website en in de berichten zelf vermeld. Zo kunnen bezoekers 
gemakkelijk soortgelijke berichten vinden. Ze helpen een bezoeker dus om de weg op je 
website te vinden. 

Zolang er geen categorie is aangemaakt, komen alle berichten terecht in de standaard-
categorie ‘Uncategorized‘. Je kunt nieuwe categorieën maken en bestaande wijzigen via 
Berichten > Categorieën. Voorbeelden voor een kattenblog zijn ‘Tips‘, ‘Dierenasiels‘, 
‘Dagboek van een kat‘ en ‘Kattenvijand‘. In veel gevallen zijn vier tot zes categorieën een 
goede manier om de content van een blog te organiseren. Je kunt dan een categorie als 
nieuwe standaardcategorie voor berichten kiezen (Instellingen > Lezen).

 
Als je vervolgens een 
bericht bewerkt, kun je de 
categorie wijzigen. In ons 
voorbeeld wijzen we ons 
eerste bericht (‘Juli is jarig‘) 
toe aan de categorie 
‘Dagboek van een kat‘.

Categorieën kunnen ook later gewijzigd worden. WordPress past de links automatisch aan. 

Bericht bewerken (rechterzijde): je kunt kiezen uit de eerder gemaakte categorieën. 
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3.2  Pagina‘s maken

Het contenttype ‘Pagina’s‘ is bedoeld voor statische content, zoals een pagina ‘Over mij‘  
of een pagina met contactgegevens. We gebruiken de contactpagina hier als voorbeeld,  
want deze mag op een website eigenlijk niet ontbreken. Technisch gezien is de procedure 
hetzelfde als voor berichten: Pagina‘s > Nieuwe pagina, content toevoegen in de editor 
en publiceren. 

We willen dat de pagina met contactgegevens na publicatie vanaf alle pagina‘s met één 
klik toegankelijk is. Daartoe zetten we een link naar deze pagina in het navigatiemenu van 
onze website óf (via een widget) in de footer. Zie hoofdstuk 2. 

3.3  Herbruikbare blokken 

Met herbruikbare blokken kun je zelf elementen maken en opslaan. Deze blokken zijn 
vooral handig voor content die je vaak nodig hebt. Je kunt per geval beslissen of en waar 
ze moeten verschijnen. Hieronder laten we je zien hoe je herbruikbare blokken kunt 
gebruiken	voor	een	affiliate-mededeling,	een	call-to-action	en	terugkerende	
gegevenstypen (bijvoorbeeld voor berichten in de categorie dierenasiels). 

Blok voor de affiliate-mededeling 

Veel	bloggers	gebruiken	affiliate-programma‘s	en	zetten	affiliate-links	in	hun	berichten.	 
Ze ontvangen dan een commissie als een bezoeker op de link klikt en iets van de partner 
koopt. Hierover moet je lezers wel informeren. Je kunt de links daarom markeren met een 
sterretje en een bijbehorende opmerking onder de tekst plaatsen: 

De links met een sterretje (*) zijn 
zogenaamde affiliate-links. Als je op een 
affiliate-link klikt en via deze link een 
aankoop doet, ontvang ik een commissie 
van de betreffende winkelier of aanbieder. 
Dit kost jou niets.

In plaats van de tekst elke keer handmatig in 
te voegen, kun je de verwijzing gewoon 
opnemen als een herbruikbaar blok: 

1. Voeg het blok ‘Paragraaf‘ toe.
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2. Voer de tekst in en formatteer de tekst indien nodig (bijv. cursief).

3. Klik in het blokmenu op het drie-puntsymbool en kies de optie Herbruikbaar 
blok maken.	Geef	het	nieuwe	blok	een	naam,	bijvoorbeeld	‘Affiliate-tekst‘,	en	
sla het op. Dit blok verschijnt nu in het bericht en in de blokbibliotheek onder de 
categorie ‘Herbruikbaar‘. Je kunt het blok net als alle andere blokken op elk 
moment via de editor in je berichten en pagina‘s invoegen. 

Blok voor een call-to-action 

Met een CTA (call-to-action) moedig je jouw lezers aan om op een link of knop te klikken. 
Het	doel	is	vaak	om	in	contact	te	komen,	een	aanbieding	te	krijgen	van	een	affiliate	
partner of een product te bestellen. De eenvoudigste manier om dit te doen is met het 
blok ‘Knoppen‘. 

1. Voeg het blok ‘Knoppen‘ in.

2. Voer de tekst en de URL in het blokmenu in.

3. Je kunt het ontwerp van de knop 
aanpassen met de blokinstellingen aan de 
rechterkant. 

4. Voeg je knop toe als herbruikbaar blok 
zoals hierboven beschreven.  

In het menu kun je de stijl veranderen (links contour, rechts vulling).  
Extra opties – bijvoorbeeld voor straal en kleuren –  

vind je in de blokinstellingen rechts. 
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Terugkerende gegevenstypen 

Wil je regelmatig artikelen schrijven over muziek, recepten of katten? Dan weet je dat 
bepaalde gegevenstypen altijd terugkomen. Bij recepten zijn dat bijvoorbeeld de 
ingrediënten of de bereidingstijd. In plaats van deze informatie telkens in de bodytekst in 
te voegen, kun je er een herbruikbaar blok voor maken. 

De procedure is vergelijkbaar met die hierboven.

1. Voeg een nieuw blok in – deze keer het blok ‘Tabel‘. 

2. Selecteer twee kolommen en evenveel rijen als datatypes. In ons 
kattenvoorbeeld is dat telkens één rij voor naam, ras, leeftijd en geslacht. 

3. Voer in de linkerkolom je gegevenstypen in. De rechterkolom blijft voorlopig 
leeg. 

4. Sla de tabel op als een herbruikbaar blok. Bij het invoegen van het blok hoef je 
alleen de rechterkolom in te vullen.  

Herbruikbaar blok ‘Tabel‘ in het kattenblog 
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3.4  Galerijen: eindeloos veel foto‘s 

Fotogalerijen zijn heel eenvoudig te maken in WordPress. Net als bij het invoegen van 
individuele afbeeldingen, klik je gewoon op de gewenste plaats in de editor, open je de 
blokbibliotheek en selecteer je het blok ‘Galerij‘. Je kunt dan nieuwe afbeeldingen 
uploaden of bestaande afbeeldingen uit de mediabibliotheek gebruiken. Nadat je op  
Een nieuwe galerij aanmaken hebt geklikt, kun je de volgorde van de foto‘s veranderen 
met drag & drop. 

Als de volgorde klopt en alle 
foto‘s tekst hebben (alt-tekst, 
titel, onderschrift), kun je de 
galerij invoegen. In de 
blokinstellingen kun je dan 
het aantal kolommen en de 
beeldformaten wijzigen. Je 
kunt direct in het blok foto‘s 
verwijderen en toevoegen. 

Om de volgorde te veranderen klik je met de muis op het plaatje en sleep je het naar de gewenste positie. 

Kattengalerij in het Twenty Twenty-thema 
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3.5  Commentaren modereren: wat is echt  
en wat is spam? 

Reacties vullen een website met leven. Daarnaast is (positieve) feedback ook een vorm 
van erkenning. Daarom zijn commentaren standaard geactiveerd in WordPress berichten. 
Onder Instellingen > Discussie vind je talloze opties om de regels voor communicatie op 
je website aan te passen. Niet elk commentaar is welkom. Sommige zijn aanstootgevend 
of	bevatten	ongewenste	reclame	(spam).	Er	zijn	speciale	spamfilter-plug-ins	voor	
WordPress die de meeste spam automatisch herkennen en naar het juiste gebied 
verplaatsen (zie hoofdstuk 4: Plug-ins gebruiken). Voor de zekerheid kun je in Instellingen 
> Discussie ook dit vakje aanvinken: ‘Reactie moet handmatig worden goedgekeurd‘. 

Tip: zelfs de beste antispam-plug-in biedt geen absolute bescherming. Daarom moet je 
altijd controleren of de opmerkingen echt zijn. Spam moet je altijd als zodanig markeren, 
zodat het in de toekomst automatisch wordt herkend. Commentaren die geen verband 
houden met de content van het artikel, zijn verdacht. Evenals commentaren die links 
bevatten naar dubieuze (of commerciële) websites of die in een vreemde taal zijn 
geschreven. Standaard word je per e-mail op de hoogte gehouden van nieuwe reacties. In 
het commentaargedeelte kun je commentaren goedkeuren, beantwoorden, bewerken, als 
spam markeren of verwijderen. Met de hierboven gekozen instelling verschijnt het 
commentaar	pas	onder	het	betreffende	bericht	als	je	het	goedkeurt.	Je	kunt	er	dan	direct	
op reageren of in het commentaargedeelte onder het bericht. 

Reacties die nog niet zijn goedgekeurd, zijn lichtgeel gemarkeerd: 

Handmatig goedkeuren is meer werk,  
maar	het	beschermt	het	blog	effectief	 

tegen ongewenste reacties. 
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Na goedkeuring verschijnen de 
reacties onder het bericht:

 

3.6 De belangrijkste shortcuts in Windows

Sneltoetsen zijn sneller en intuïtiever dan het gebruik van de muis en menu‘s. Als je vaak 
je website bewerkt, wil je deze combinaties niet meer missen. De beste manier om ermee 
te leren werken, is met eenvoudige sneltoetsen die je al kent uit andere programma‘s. 

Je kent waarschijnlijk de toetscombinaties Ctrl + C (kopiëren) en Ctrl + V (plakken). De 
snelkoppelingen van WordPress verschillen echter deels van die van andere software.  
Er zijn er een paar voor het schrijven en het commentaargedeelte. 

Snelkoppelingen voor de editor 

Naast de hierboven genoemde snelkoppelingen voor kopiëren en plakken ken je 
waarschijnlijk deze combinaties: 

Opslaan: Ctrl + S 
Ongedaan maken: Ctrl + Z 
De hele tekst selecteren: Ctrl + A

Er zijn nog andere handige 
sneltoetsen voor opmaak: 

Geselecteerde tekst  
vet maken: Ctrl + B (bold)
Geselecteerde tekst  
cursiveren: Ctrl + I (italic)
Geselecteerde tekst  
onderstrepen: Ctrl + U (underline) Tekst opmaken zonder blokmenu in de editor 



43STRATO | WordPress voor beginners

Met deze eenvoudige combinaties van twee 
toetsen kom je een heel eind. Natuurlijk kun je 
ook andere combinaties gebruiken. Maar let 
op, de toetsencombinaties werken niet altijd, 
omdat sommige combinaties een andere 
functie hebben in de browser. Zo opent  
Shift + Alt + H niet alleen de lijst met snel-
toetsen, maar ook het hulpmenu van Firefox.

Er is een lijst van alle sneltoetsen die je via het 
driepuntsmenu rechtsboven kunt oproepen.

Snelkoppelingen voor reacties

Als je veel reacties ontvangt, is het handig om 
ook de sneltoetsen voor de commentaar-
functie te activeren (Gebruiker > Je profiel > 
Toetsenbord snelkoppelingen inschakelen 
voor het modereren van reacties). Dan kun 
je in het overzicht navigeren met J (omlaag) en 
K (omhoog). De geselecteerde reactie wordt 
blauw gemarkeerd.

Je kunt de geselecteerde reactie nu direct met het toetsenbord bewerken: 

Reactie goedkeuren: A (approve) 
Reactie markeren als spam: S (spam) 
Reactie verwijderen: D (delete) 
Reageer op een reactie: R (reply) 

In dit voorbeeld is het tweede commentaar van boven geselecteerd. 

Hier vind je alle snelkoppelingen voor het commentaargebied.

https://wordpress.org/documentation/article/keyboard-shortcuts-classic-editor/#using-keyboard-shortcuts-to-perform-actions-on-comments
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4   Plug-ins gebruiken 
In de vorige hoofdstukken heb je de basisbeginselen van WordPress leren kennen.  
Nu kun je jouw website uitbreiden met extra functies. Dat doe je met kleine 
softwarecomponenten, de zogeheten plug-ins. We laten je in dit vierde hoofdstuk zien  
hoe je ze installeert. Plug-ins zijn kleine programma‘s die extra functies aan WordPress 
toevoegen. Dit kan iets simpels zijn als een kleine Twitter volgknop. Maar ook grote 
uitbreidingen zijn mogelijk, zoals een discussieforum. Om een plug-in te gebruiken, moet 
je die eerst opzoeken, installeren en dan activeren. 

De beste plek om te starten, is de officiële	plug-indirectory, die tienduizenden gratis 
plug-ins bevat voor bijna elk doel. Maar er zijn ook programmeurs die betaalde plug-ins 
aanbieden. Zij verkopen hun software bijvoorbeeld via hun eigen website of in online 
winkels, zoals Code Canyon.

Verder kun je goede plug-ins vinden door via Google te zoeken op ‘wordpress plug-in‘ plus 
de functie die je wilt hebben. Gebruik bijvoorbeeld ‘contactformulier‘ om te zoeken naar 
een contactformulier. Een kleine tip: met Engelse zoektermen vind je meer dan met 
Nederlandse. 

De WordPress plug-indirectory inclusief zoekfunctie 

https://nl.wordpress.org/plugins/
https://codecanyon.net/category/wordpress
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4.1		 Hoe	installeer	je	een	nieuwe	plug-in?

Er zijn drie manieren om een plug-in te installeren, die we hieronder in detail zullen 
bespreken: 

1. Zoek	de	desbetreffende	plug-in	op	in	de	admin-interface	van	WordPress	onder	
Plugins > Nieuwe plugin en installeer hem daar direct.

2. Je kunt een plug-in die je eerder van internet hebt gedownload, uploaden in de 
admin-interface van WordPress. Dat doe je via Plugins > Nieuwe plugin. 
Installeer hem daar direct via de knop Plugin uploaden bovenin het venster.

3. Je kunt ook een eerder van internet gedownloade plug-in via SFTP uploaden 
naar je webspace. 

4.1.1	 Een	plug-in	direct	installeren

Meestal kun je een nieuwe plug-in eenvoudig direct in de backend van WordPress 
opzoeken	en	installeren.	Dit	werkt	altijd	als	de	plug-in	beschikbaar	is	in	de	officiële	
directory van WordPress. 

Ga daarvoor in WordPress naar Plugins > Nieuwe 
plugin	en	zoek	de	betreffende	plug-in	met	behulp	
van het invoerveld rechtsboven. Heb je de juiste 
gevonden? Dan klik je op de knop Nu installeren. 
Na een succesvolle installatie kun je de plug-in ook 
activeren door te klikken op de knop Activeren.

Plug-in direct in WordPress zoeken 

Je kunt plug-ins vaak met één muisklik installeren. 
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4.1.2		 Een	zip-bestand	uploaden	naar	WordPress

Als een plug-in afkomstig is van een derde partij, heb je doorgaans een zip-bestand dat 
alle plug-inbestanden bevat. WordPress biedt ook voor dit geval een eenvoudige 
installatieprocedure. 

Klik op de knop Plugin uploaden onder Plugins > Nieuwe plugin. Kies dan het zip-
bestand en klik op de installeren-knop. Vervolgens kun je de plug-in onmiddellijk 
activeren, net als bij de directe installatie.

4.1.3	 De	plug-in	installeren	via	SFTP

Lukken	installatiemethoden	1	en	2	niet?	Dan	kun	je	als	laatste	optie	de	plug-in	via	SFTP	
uploaden. Dit is bijvoorbeeld handig als het zip-bestand zo groot is dat de server een 
time-out meldt tijdens het uploaden. 

Eerst upload je de plug-in als een zip-bestand ... 

... en installeer hem met één klik.
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Om een plug-in via SFTP te installeren, pak je eerst het zip-bestand uit op je lokale harde 
schijf. Er wordt een nieuwe map aangemaakt met de naam van de plug-in. Je uploadt deze 
map nu met een SFTP-client naar de plug-inmap van je webspace. Hoe je bestanden via 
SFTP naar je webspace uploadt, lees je in onze FAQ. 

Plug-ins hebben in WordPress hun eigen map onder de hoofdmap /wp-content/plugins/. 
De plug-in Table Press bevindt zich bijvoorbeeld hier: /wp-content/plugins/tablepress/.

Zodra het plug-inbestand op de server verschijnt onder /wp-content/plugins/, herkent 
WordPress het automatisch. De plug-in wordt nu in de lijst met geïnstalleerde plug-ins 
getoond.  

In de STRATO klantenlogin vind je de hoofdmap van je WordPress installatie onder 
Domeinen > Domeinbeheer. Kies hier de domeinnaam waaronder de website draait en 
bekijk	het	omleidingsdoel.	Voorbeeld:	‘Omleiding	(Intern):	/STRATO-apps/wordpress_01/‘.	
In	dit	voorbeeld	is	/STRATO-apps/wordpress_01/wp-content/plugins/	de	plug-inmap.

Zodra je de map met de plug-in daarheen hebt gekopieerd, verschijnt hij in de lijst met 
geïnstalleerde plug-ins in WordPress. Je kunt hem daar activeren. 

4.2 De plug-in activeren

Vergeet niet dat het installeren van een plug-in altijd twee stappen omvat: het kopiëren 
van de plug-in naar de plug-inmap én het activeren ervan. Pas als je hem na de installatie 
activeert, kun je de plug-in daadwerkelijk gebruiken.

Plug-ins activeren en deactiveren met één muisklik 

https://www.strato.nl/faq/hosting/zo-maak-je-verbinding-met-de-sftp-server/
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Omgekeerd betekent dit ook dat je een plug-in niet helemaal uit WordPress hoeft te 
verwijderen als je hem een tijdje niet wilt gebruiken. Het is voldoende om de plug-in  
te deactiveren. Dan werkt hij niet meer. 

Wil je een plug-in helemaal niet meer gebruiken? Dan raden we je aan om hem wél 
volledig te verwijderen. Dit is veiliger (meer hierover in het volgende hoofdstuk). Klik 
hiervoor eerst op Deactiveren, dan op Verwijderen en bevestig het door te klikken op  
Ja, verwijder deze bestanden en gegevens. 

4.3 Plug-in  
configureren

Heb je een nieuwe plug-in geïnstalleerd? 
Dan ontbreekt nog de laatste stap: de 
configuratie.	In	sommige	plug-ins	zijn	de	
optimale instellingen al voorgeselecteerd. 
Maar het is altijd de moeite waard om de 
configuratiemenu‘s	te	bekijken	en	zo	de	
plug-in perfect aan te passen aan je eigen 
wensen. 

Helaas is er geen vaste plek voor de 
configuratiemenu‘s	van	een	plug-in.	 
De meeste plug-ins voegen een menu-item  
toe onder Instellingen, maar sommige 
doen dat onder Extra, Weergave of 
Berichten. Uitgebreidere plug-ins vind je 
soms als hoofditem in de WordPress 
backend. En soms staat er alleen een 
onopvallende link Instellingen in de lijst 
van geïnstalleerde plug-ins. Het kan dus 
gebeuren dat je na de activering moet 
zoeken naar de instellingen. Gelukkig zijn er 
ook heel eenvoudige plug-ins die helemaal  
geen	configuratie	vereisen.	

Vergeet niet om plug-ins altijd up-to-date te houden. Alles wat je moet weten over 
beveiliging, vind je in het volgende hoofdstuk.

Afhankelijk	van	de	plug-in	is	het	configuratiemenu	te	vinden	 
in het plug-inoverzicht of in het menu links. 
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5  Veiligheid en prestaties 

5.1		 WordPress	veilig	maken

Een gehackte website kan veel schade aanrichten. In dit laatste hoofdstuk laten we zien 
hoe je jouw WordPress kunt beschermen tegen aanvallers en malware. Tot slot geven we 
tips om je website sneller te maken.

5.1.1	 Gebruik	veilige	gebruikersnamen	en	wachtwoorden

De veiligheid van je WordPress website hangt vooral af 
van de inloggegevens die je gebruikt. Bij zogenaamde 
brute force-attacks proberen aanvallers toegangs-
gegevens te verkrijgen via geautomatiseerd testen.  
Zo proberen ze in korte tijd massa‘s aan gebruikers-
namen en wachtwoorden uit. Bij veelgebruikte termen is 
het dan slechts een kwestie van tijd voordat je website 
gehackt is.

Standaardnamen als ‘admin‘ 
of de publiekelijk zichtbare 
auteursnaam zijn bijzonder 
populair en daarom geen 
goed idee voor een 
gebruikersnaam. Om het 
hackers moeilijker te maken, 
kun je het best een geheime, 
complexe gebruikersnaam 
kiezen in combinatie met 
een veilig wachtwoord. Voor 
een complexe gebruikers-
naam is een wachtwoord-
manager als KeePass erg 
handig. Dat stelt een sterk 
wachtwoord voor, dat je 
vervolgens als gebruikers-
naam kunt gebruiken. 

Als de verkeerde toegangsgegevens worden ingevoerd, geeft WordPress 
foutmeldingen. Maar dit is ook de manier waarop aanvallers erachter komen 

of een gebruikersnaam bestaat of niet. 

Met KeePass kun je toegangsgegevens opslaan in mappen.  
Zo houd je het overzicht, ook als je veel accounts hebt. 
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Tip: met het gratis programma KeePass kun je al je inloggegevens versleuteld opslaan.  
De hiervoor benodigde database wordt direct na de installatie aangemaakt. Nadat je een 
veilige opslagplaats en een hoofdwachtwoord hebt gekozen, kun je nieuwe toegangen 
voor individuele accounts aanmaken. Het programma genereert complexe zinnen via 
Tools > Generate password. Later kun je de inloggegevens gewoon kopiëren en plakken 
in de browser. 

Als je tijdens het installatieproces al een onveilige login hebt aangemaakt, kun je eerst een 
nieuwe gebruiker aanmaken (Gebruikers > Nieuwe toevoegen) en daarna de oude 
gebruiker verwijderen. 

1. Een nieuwe gebruiker toevoegen:

• Voer voor de 
gebruikersnaam een 
willekeurige 
tekenreeks in en schrijf 
die op. Dit is de niet-
openbare naam die je 
later nodig hebt om in 
te loggen. 

• Het e-mailadres mag 
niet gebruikt worden 
door een andere 
actieve gebruiker.

• De voor- en 
achternaam worden 
(afhankelijk van het 
thema) weergegeven 
in de berichten en 
pagina‘s die je maakt.

• Je kunt het 
wachtwoord gebruiken 
dat WordPress heeft 
voorgesteld. Maar 
noteer dit goed!

• Belangrijk: je moet de 
rol van administrator 
opgeven zodat je nog 
steeds alle rechten hebt, bijvoorbeeld om plug-ins of thema‘s te installeren. 
De andere rollen heb je nodig voor gebruikers die geen administrator 
mogen	zijn.	Meer	hierover	lees	je	in	hoofdstuk	5.1.2	Rechtenbeheer.	
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2. De oude gebruiker verwijderen: 

• Log nu uit en log in met een nieuwe gebruikersnaam en wachtwoord. Onder 
Gebruikers > Alle gebruikers vind je het gebruikersoverzicht. Om de oude 
gebruiker (hier: ‘Jeroen‘) te verwijderen, beweeg je de muisaanwijzer over de 
naam en selecteer je Verwijderen. 

• Belangrijk: om geen inhoud te verliezen, kies je in het 
volgende dialoogvenster de optie Alle content aan 
deze gebruiker toewijzen. Kies de nieuwe gebruiker 
in het keuzemenu. Hierdoor worden alle berichten en 
pagina‘s van de oude gebruiker overgezet naar de 
nieuwe. Na het klikken op Verwijdering bevestigen 
is de oude gebruiker verwijderd en is inloggen alleen 
nog mogelijk met de nieuwe toegangsgegevens.

5.1.2		 Rechtenbeheer

De hierboven verleende beheerdersrechten zijn niet voor alle gebruikers van je website 
nodig. Niet voor niets kent WordPress vijf gebruikersrollen met een hiërarchische 
toekenning van rechten. Dit betekent dat de hogere niveaus automatisch ook de rechten 
hebben van de lagere niveaus.

Niveau Rol Rechten Geschikt voor

1 Beheerder Inhoud, reacties, plug-ins en 
thema‘s beheren

Medewerkers die WordPress ervaring hebben 
en verantwoordelijk zijn voor het beheer en de 
techniek

2 Redacteur Alle content en reacties beheren Medewerkers met WordPress ervaring

3 Auteur Eigen content publiceren en de 
reacties erop beheren

Externen met WordPress ervaring

4 Bijdrager Eigen content schrijven, maar niet 
zelf publiceren

Externen met weinig WordPress ervaring

5 Abonnee Inloggen,	eigen	profiel	beheren,	
reageren

Websites waarop alleen ingelogde bezoekers 
mogen reageren
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Als	je	deze	gedifferentieerde	rolverdeling	goed	gebruikt,	verklein	je	het	gevaar	van	
hackers. Elke inlogpoging brengt immers een veiligheidsrisico met zich mee, vooral in 
onbekende	wifinetwerken	of	in	internetcafés.	Voor	een	blog	is	daarom	een	gebruiker	met	
de rol van redacteur genoeg. Mocht een hacker dat wachtwoord daadwerkelijk stelen, dan 
krijgt hij met deze gebruikersrol in ieder geval geen toegang tot de algemene instellingen 
van WordPress. 

5.1.3		 Houd	WordPress	altijd	up-to-date

Om de zaak veilig te houden, moet je het systeem ook altijd up-to-date houden. Bij 
WordPress	worden	zogenaamde	minor	releases	(bijvoorbeeld	WP	5.2.1,	5.2.2,	5.2.3	...)	
automatisch geïnstalleerd. Deze zijn vooral bedoeld voor onderhoud en beveiliging. Grote 
releases zoals WordPress 5.3 of 5.4 moet je handmatig installeren. Zulke releases 
bevatten nieuwe functies. Meestal worden ook plug-ins en thema‘s aangepast aan nieuwe 
standaarden. Om risico‘s te vermijden, moet je altijd de nieuwste WordPress versie 
gebruiken. 

Er zijn ook updates voor thema‘s en plug-ins. Alle actuele updates zie je in de backend 
(Dashboard > Updates).	Je	kunt	een	update	starten	door	de	desbetreffende	knop	aan	
te klikken. 

WordPress geeft updates weer op het dashboard. Hier is alles in orde. 
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Naast tijdige updates moet je voor plug-ins en thema‘s ook altijd het volgende overwegen: 

• De	beste	bron	is	de	officiële	WordPress	directory.	Let	bij	het	kiezen	op	de	datum	
van de laatste update, het aantal downloads, beoordelingen en feedback in de 
forums. 

• Controleer bij het updaten van WordPress altijd vooraf of het thema en de 
plug-ins compatibel zijn met de nieuwe versie.

• Plug-ins en thema‘s die je niet nodig hebt (behalve een vervangend thema voor 
noodgevallen) moet je niet deactiveren, maar verwijderen.

• Hoe minder extra software aan boord, hoe beter. WordPress draait veiliger en 
sneller met weinig plug-ins! 

5.1.4		 Webspace	beschermen	tegen	gevaarlijke	toegang

Websites worden dagelijks aangevallen door kwaadaardige software. Deze zogenaamde 
malware	komt	binnen	via	verouderde	programma‘s	en	gaten	in	de	beveiliging.	Een	firewall	
en andere beschermingsmechanismen kunnen helpen ongewenste toegang te blokkeren. 

5.1.4.1  Wordfence Security

De extensie ‘Wordfence Security‘ is een aanrader. Deze beveiligingsplug-in wordt erg veel 
gebruikt, hij is al meer dan vier miljoen keer geïnstalleerd. De hoeveelheid functies is zo 
groot	dat	we	ons	hier	beperken	tot	één	centrale	functie:	de	firewall.	

Eerst installeren we de plug-in zoals beschreven in hoofdstuk 4. De vele instellings-
mogelijkheden kunnen in het begin intimiderend lijken. Maar maak je geen zorgen: 
dankzij de rondleiding (in het Engels) en de eenvoudige dialoogvensters is de plug-in  
in een paar stappen klaar voor gebruik. 

Je e-mailadres  
invoeren 

Aan het eind van de installatie 
moet je een e-mailadres 
invoeren, waarnaar het 
programma 
veiligheidswaarschuwingen 
kan sturen. Wil je je niet 
aanmelden voor de 
nieuwsbrief? Kies dan No 
onder het invoerveld. 
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De firewall laten leren 

Nu verschijnt het nieuwe menu-item 
Wordfence in de WordPress backend 
onder Instellingen. Pop-upvensters 
leggen de basisfuncties van de plug-in 
uit. Hier leer je bijvoorbeeld dat de 
firewall	een	week	lang	in	de	leermodus	
staat. In deze tijd leert de plug-in 
onderscheid te maken tussen gewenste 
en ongewenste verzoeken. Gebruik 
daarom WordPress, thema‘s en plug-ins 
gedurende deze tijd zo intensief 
mogelijk. Standaard activeert 
Wordfence	de	firewall	automatisch	na	
een week.

Firewall optimaliseren 

Klik bovenaan naast ‘To make your site as secure as possible, take a moment to optimize 
the Wordfence Web Application Firewall‘ op Click here to configure. In de volgende stap 
kun je de basisinstellingen accepteren. Belangrijk: klik eerst op Download .htaccess om 
een back-up van het bestand te maken en dan op Continue.

Wordfence-firewallstatus	na	installatie	
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Nu	zou	je	een	bericht	moeten	krijgen	dat	de	firewall	geoptimaliseerd	is.	

Kom je problemen tegen? Upload dan het eerder opgeslagen .htaccess-bestand via SFTP 
en vervang het bestaande. Het bestand hoort in de bovenste map van je WordPress 
installatie te staan. Bij een automatische installatie met STRATO heeft deze map een naam 
als STRATO-apps/wordpress_01/. Hoe je verbinding maakt met de STRATO SFTP-server 
lees je in onze FAQ. 

Automatisch updaten instellen 

Tot slot vraagt de plug-in of deze automatisch geüpdatet moet worden. Omdat dit een 
goed idee is, kun je in het bijbehorende dialoogvenster het beste klikken op Yes, enable 
auto-update.

 

5.1.4.2 Standaard geïnstalleerde WordPress plug-ins

Heb je WordPress geïnstalleerd via de STRATO installatiehulp? Dan heeft jouw WordPress 
al diverse beveiligingsplug-ins geïnstalleerd. Belangrijk: om je WordPress veiliger te 
maken, moet je die plug-ins in de WordPress backend activeren. 

Sinds juli 2020 zijn de volgende plug-ins aanwezig: 

• Meta Generator And Version Info Remover verbergt het versienummer van je 
installatie. Dit maakt het moeilijker voor aanvallers om beveiligingslekken uit te 
buiten. De plug-in is in principe zo ingesteld dat alle beveiligingsfuncties 
geactiveerd zijn. In de instellingen van de plug-in, onder Version Info Remover 
Settings, moet je in elk geval de functies Remove version from stylesheet en 
Remove version from script kiezen. Het is zelfs beter om alle beveiligings-
functies ingeschakeld te houden. 

• WPS Hide Login biedt nog meer bescherming. Met deze plug-in kun je de 
standaard-URL van het inloggedeelte veranderen. Je kunt in de instellingen van 
de	plug-in	een	alternatieve	inlog-URL	configureren.	Standaard	is	altijd	
jouwdomein.nl/?login. Belangrijk: noteer de nieuwe URL, want de 
standaardlogin werkt na de wijziging niet meer. 

• WP Limit Login Attempts Reloaded beperkt het aantal inlogpogingen. Dit maakt 
het veel moeilijker voor aanvallers om in je backend te komen door toegangs-
gegevens uit te proberen. Na activering kun je het aantal inlogpogingen 
instellen in het hoofdmenu van je WordPress onder Instellingen > WP Limit 
Login Attempts Reloaded.

https://www.strato.nl/faq/hosting/zo-maak-je-verbinding-met-de-sftp-server/
https://wordpress.org/plugins/meta-generator-and-version-info-remover/
https://wordpress.org/plugins/wps-hide-login/
https://wordpress.org/plugins/limit-login-attempts-reloaded/
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5.1.4.3  STRATO SiteGuard

STRATO	SiteGuard	biedt	ook	uitgebreide	en	flexibele	bescherming	tegen	hackers.	De	
gratis tool maakt schrijfbeveiliging mogelijk voor alle mappen of geselecteerde mappen. 
Dit maakt het voor hackers en andere indringers moeilijk om ongeautoriseerde toegang 
tot je webspace te krijgen. Extra bescherming krijg je als je de SSH- en SFTP-toegang 
uitschakelt. 

Schrijfbeveiliging instellen 

Een volledige schrijfbeveiliging is te beperkend voor de essentiële functies van WordPress. 
Daarom	configureren	we	dit	alleen	voor	de	mappen	van	thema‘s	en	plug-ins,	omdat	dit	
vaak zwakke punten zijn. Zo stel je de schrijfbeveiliging in: 

• Activeer STRATO SiteGuard via de 
klantenlogin (Beveiliging > 
SiteGuard).

• In STRATO SiteGuard kies je onder 
Schrijfbeveiliging de mappen 
waarvoor de schrijfbeveiliging niet 
moet worden geactiveerd. Hiervoor 
voeg je alle mappen in de hoofdmap 
van de WordPress installatie van de 
webspace toe, behalve /wp-content/. 
Voor de map wp-admin werkt het 
bijvoorbeeld als volgt: selecteer de 
blauwe vermelding /wp-admin/ en klik 
dan op Map toevoegen.

• Ga nu naar de map /wp-content/ en 
voeg op dezelfde manier alle mappen 
behalve /themes/ en /plugins/ toe aan 
de uitzonderingen. Tenslotte sla je het 
geheel op. Nu zijn de mappen voor 
thema‘s en plug-ins schrijfbeveiligd. 

Let op: als je plug-ins of thema‘s wilt bijwerken, installeren of verwijderen, moet je tijdelijk 
de bijbehorende map aan de uitzonderingen toevoegen. Is alles klaar? Dan kun je de map 
weer uit de lijst verwijderen en zo de schrijfbeveiliging weer activeren. 

In dit voorbeeld is de hoofddirectory van de WordPress installatie  
/STRATO-apps/wordpress_01/app/.	Om	een	directory	aan	de	 

uitzonderingen toe te voegen, kies je een vermelding (in blauw) en 
vervolgens de knop ‘Map toevoegen‘.
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SFTP- en SSH-toegang 

Ter bescherming tegen onbevoegde toegang kun je ook de SFTP- en SSH-toegang 
uitschakelen. Dit zijn protocollen die gebruikt kunnen worden om data te versturen en 
serveropdrachten uit te voeren. Je hebt deze niet nodig voor alledaagse WordPress taken. 
Schakel ze daarom uit. Zo sluit je mogelijke beveiligingslekken. Heb je ze op een gegeven 
moment toch nodig? Dan kun je ze weer inschakelen. 

5.2  Back-ups maken

Welke maatregelen je als beheerder ook neemt, absolute veiligheid bestaat niet. Daarom 
zijn regelmatige back-ups onmisbaar. Zo kun je zelfs bij een totaal verlies van gegevens de 
laatst opgeslagen toestand van je website herstellen.

STRATO Backup Control 

Als je WordPress draait met de STRATO WordPress hostingpakketten, kun je heel 
eenvoudig back-ups maken en terugzetten. Je hebt namelijk toegang tot Backup Control in 
de STRATO klantenlogin via Beveiliging > Back-upbeheer. Op de volgende pagina kies je 
Toepassingen (Website-apps) en vervolgens je WordPress. 

Deactiveer alle SFTP- en SSH-toegangen die je niet nodig hebt.

Links wordt alleen de webspace geback-upt, rechts de complete website (webspace en database). 
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Je hebt twee opslagruimtes tot je beschikking: eentje voor een automatische en één voor 
een handmatige back-up. Je kunt wekelijks of maandelijks automatische back-ups 
aanmaken. Telkens als Backup Control een nieuwe back-up aanmaakt, wordt de oudste 
back-up overschreven. 

Tip: het is handig om een wekelijkse automatische back-up te combineren met een 
maandelijkse handmatige back-up. Zo heb je in geval van nood de keuze tussen twee 
verschillende back-ups. Natuurlijk kun je ook handmatige back-ups aanmaken na elke 
update of na een bepaald aantal nieuwe berichten of pagina‘s. 

5.3 Wat te doen in geval van nood?

WordPress gebruikers hebben vaak niet eens door dat hun webspace is geïnfecteerd  
door malware. Om dit te ontdekken en zo vroeg mogelijk te handelen, zijn er tools als 
Wordfence Security en STRATO SiteLock. Kun je niet meer inloggen op WordPress?  
Dan is je website wellicht gehackt.

We laten je stap voor stap zien wat je in dit geval moet doen. 

5.3.1		 Stap	1:	wijzig	de	toegangsgegevens

Allereerst moet je de STRATO wachtwoorden, het WordPress wachtwoord en eventuele 
actieve SFTP-toegang veranderen, zodat hackers geen toegang meer kunnen krijgen. 

Wijzig de STRATO wachtwoorden 

Om de STRATO wachtwoorden te wijzigen, log je in met je klantnummer en wachtwoord. 
Voer een nieuw klantenwachtwoord in via Contractgegevens > Klantenwachtwoord 
wijzigen. Heb je pakket- en masterwachtwoorden aangemaakt? Dan kun je deze  
ook wijzigen als je inlogt op je pakket. Ga vervolgens naar Beveiliging > Wachtwoorden 
wijzigen.

Voor	ons	kattenblog	zijn	de	automatische	back-ups	al	geconfigureerd.	Is	dat	bij	 
jouw website niet het geval? Dan kun je in de klantenlogin zelf een back-up instellen. 
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WordPress wachtwoord wijzigen

Kun je nog inloggen op WordPress? Wijzig dan het wachtwoord van je beheerdersaccount 
via Gebruikers > Profiel > Nieuw wachtwoord instellen. Controleer ook meteen of je 
geregistreerde e-mailadres nog klopt en of er nieuwe gebruikers zijn aangemaakt 
(Gebruikers > Alle gebruikers). Onbekende gebruikers moet je onmiddellijk verwijderen. 

SFTP-toegang beveiligen

Als hostingklant heb je standaard een algemene SFTP-toegang met het domein als 
gebruikersnaam en het masterwachtwoord als wachtwoord. Heb je het 
masterwachtwoord al gewijzigd? Of is de SFTP-toegang al door SiteGuard uitgeschakeld? 
Dan hoef je verder niets te doen. Voor zelf aangemaakte SFTP-toegangen kun je de 
wachtwoorden in de klantenlogin wijzigen. Log in op je pakket en ga vervolgens naar 
Databases en webspace > SFTP Management. Onbekende SFTP-toegangen moet je 
onmiddellijk verwijderen. Meer informatie over de vooraf ingestelde SFTP-toegang lees je 
in onze FAQ.

Het eerste wat je moet doen is je klantenwachtwoord wijzigen. 

Heb je een nieuw wachtwoord nodig? WordPress stelt automatisch een veilig wachtwoord voor. 

https://www.strato.nl/faq/hosting/hoe-maak-ik-sftp-accounts-aan/
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5.3.2  Stap 2: bescherm je bezoekers

Websites worden vaak aangevallen met het doel bezoekers te infecteren met malware. 
Om websitebezoekers te beschermen, moet eerst de verbinding met WordPress worden 
verbroken (STRATO Klantenlogin > Domeinen > Domeinbeheer). In het domeinbeheer 
klikken we naast het domein op het tandwieltje en vervolgens op Forward verwijderen. 
Dit heeft tot gevolg dat bezoekers worden omgeleid naar de rootmap. 

Nadat je de omleiding van je domein opnieuw hebt ingesteld, ziet je website eruit alsof  
je het domein net hebt besteld. Daarom verschijnt ook de STRATO melding dat de website 
net is geactiveerd (zie het screenshot rechtsboven). Je bezoekers komen dus niet in 
aanraking met het geïnfecteerde WordPress.

STRATO WordPress hostingpakketten bevatten ten minste één vooraf ingestelde SFTP-toegang. 

Het	kattenblog	is	geïnstalleerd	in	de	directory	/STRATO-apps/wordpress_01/app/.	 
Door de domeinomleiding uit te schakelen, worden bezoekers niet meer naar  

het blog geleid, maar naar de hoofdmap. 
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5.3.3 Stap 3: controleer de webspace

Zodra de toegangen zijn beveiligd, is het tijd om de webspace te scannen op malware, 
gewijzigde bestanden en andere afwijkingen. Wordfence Security en STRATO SiteLock 
kunnen je hierbij helpen. Slaan de tools alarm? Dan moet je vrijwel altijd alles opnieuw 
installeren. 

De scan met Wordfence starten

Wordfence biedt niet alleen een firewall, maar ook een krachtige malwarescanner. Heb je 
nog toegang tot WordPress? Start dan de functie via Wordfence > Scan > Nieuwe scan 
starten. Nadat de scan is voltooid, krijg je in het beste geval de melding dat er geen 
problemen konden worden gevonden:

Zo niet, zie je de resultaten in de tabel. Omdat elke fout verschillende oorzaken heeft, 
kunnen we geen algemene oplossing geven. Een vals alarm komt soms ook voor (een 
‘false positive‘). Als je vastloopt met foutmeldingen, kun je meer informatie en hulp vinden 
op diverse websites, zoals het officiële WordPress forum. 

STRATO SiteLock 

In tegenstelling tot Wordfence werkt STRATO SiteLock onafhankelijk van WordPress. Het is 
een betaalde tool die de website regelmatig controleert op kwetsbaarheden en die 
handige tips geeft om beveiligingslekken te voorkomen. Zo schakel je STRATO SiteLock in: 
STRATO Klantenlogin > Beveiliging > STRATO SiteLock > Start alle scans. 

De tool zoekt niet alleen naar malware, maar ook naar bijvoorbeeld SQL-injecties en cross-
site-scripting. Beide zijn populaire methoden om kwaadaardige code in de database en de 
webspace te plaatsen. Groene vinkjes in SiteLock betekenen dat alles in orde is. 

Een bijzonder kenmerk van STRATO SiteLock zijn de tips die je op kwetsbaarheden wijzen. 
De tool adviseert je dan bijvoorbeeld om het inloggedeelte te beveiligen met een SSL-
certificaat. Zulke op maat gesneden adviezen helpen je om risico‘s vooraf te herkennen en 
te voorkomen. 

https://wordpress.org/documentation/
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5.3.4  Stap 4: back-up terugzetten of herinstallatie

Het herstellen van een beschadigde WordPress is kostbaar en riskant. De kans is groot  
dat je iets over het hoofd ziet. Twijfel je? Dan heb je twee opties. Je kunt een oude back-up 
terugzetten of WordPress helemaal opnieuw installeren. Met STRATO Backup Control kun 
je de oude toestand zonder problemen herstellen.

Een back-up terugzetten

Om de eerste optie te proberen, ga je terug naar de klantenlogin (Beveiliging >  
Back-upbeheer) en selecteer je de optie Toepassingen (Website-apps): 

Vervolgens blader je omlaag tot je jouw WordPress website ziet. Daar klik je op Details & 
functies. Je hebt bij de STRATO WordPress hostingpakketten maximaal twee back-ups  
ter beschikking, één handmatige back-up en één automatische back-up. Kies zo mogelijk 
een tijdstip vóór het moment waarop de hack plaatsvond. Gebruik de scanresultaten om 
dit tijdstip te vinden. Lukt het niet? Dan kun je het beste een oudere versie gebruiken.  
Zo verklein je het risico dat je een geïnfecteerde back-up importeert. Nadat je op 
Terugzetten hebt geklikt, bevestig je het proces door op Actie uitvoeren te klikken.  
 
Let op: alle content 
(tekst, afbeeldingen, 
enz.) die na de back-up 
is aangemaakt, gaat 
onherroepelijk 
verloren!

In dit voorbeeld is er alleen een automatische back-up aanwezig en wordt  
WordPress	hersteld	naar	de	status	van	21-02-2023	(02.24	uur).	
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WordPress opnieuw installeren 

In het ergste geval zijn beide beschikbare back-ups al geïnfecteerd. Dan heb je geen 
andere keuze dan WordPress opnieuw te installeren. Verwijder hiervoor de oude 
applicatie via STRATO Klantenlogin > Website-apps. Blader omlaag en klik achter  
je website op Details & functies. In het volgende venster kun je de site verwijderen. 
Belangrijk: alle inhoud gaat onherroepelijk verloren!

Vervolgens	kun	je	WordPress	opnieuw	instellen	(zie	hoofdstuk	1:	Automatische	installatie	
met STRATO). 

5.4 WordPress sneller maken

We noemden al een belangrijke hint voor meer prestaties: hoe minder thema‘s en plug-ins 
je hebt geïnstalleerd, hoe sneller WordPress kan werken. Vooral uitgebreide plug-ins met 
veel (onnodige) functies vertragen het systeem. Maar er zijn twee plug-ins die we tóch 
willen aanbevelen, omdat ze je systeem versnellen. 

5.4.1		 Caching	activeren	met	Cache	Enabler

Met caching worden pagina‘s die de server opbouwt, tijdelijk 
opgeslagen. Deze voltooide pagina‘s hoeven dan alleen maar 
opgehaald te worden, dus niet opnieuw gebouwd. Daardoor 
laden ze merkbaar sneller bij grote aantallen bezoekers. Voor 
deze taak kunnen veel plug-ins worden gebruikt. Wij raden 
Cache Enabler aan. 

WordPress installatie verwijderen in de STRATO klantenlogin 

https://wordpress.org/plugins/cache-enabler/
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Deze slanke plug-in doet wat hij moet doen en biedt alleen de écht belangrijke opties. Die 
kun je na de installatie bereiken via Instellingen > Cache Enabler. Je kunt onder andere 
aangeven hoe lang de cache gebruikt moet worden. In ons voorbeeld hebben we gekozen 
voor 24 uur. Het is ook zinvol om de cache te wissen bij het verschijnen van nieuwe 
artikelen en bij updates van de plug-in, en om compressie te activeren. 

Alles wat belangrijk is in één oogopslag: de instellingen van Cache Enabler



65STRATO | WordPress voor beginners

5.4.2 Foto‘s laden met Lazy Loading

Artikelen met (katten)foto‘s zijn aantrekkelijker dan artikelen met alleen tekst. Maar elke 
afbeelding beïnvloedt de laadsnelheid, simpelweg omdat er meer data moet worden 
verwerkt. Dit heeft vooral gevolgen voor de homepage, want daar staan veel 
artikelafbeeldingen. 

Het snellere alternatief is: niet wachten tot alle afbeeldingen zijn geladen, maar alleen de 
afbeeldingen in het zichtbare gedeelte laden. Dat ontlast de internetverbinding. Omdat 
alleen de benodigde afbeeldingen worden geladen, verbeteren de prestaties van je 
website fors. Dit wordt ook wel Lazy Loading genoemd.

Er	zijn	verschillende	plug-ins	waarmee	je	Lazy	Loading	kunt	configureren,	zoals	 
Smush en Optimole.

5.4.3 PHP 8.2 en PHP Boost inschakelen

WordPress is een PHP-toepassing en draait bijzonder snel op actuele PHP-versies. Je  
kunt de nieuwste PHP-versie voor je STRATO pakket activeren via de STRATO klantenlogin 
(Databases en webspace > PHP-versie instellen). Vink dan ook het vakje voor  
PHP Boost	aan,	waardoor	PHP-scripts	tot	100	procent	sneller	worden	uitgevoerd.	Je	moet	
de	prestaties	van	je	website	daarna	meteen	even	testen.	Als	WordPress	of	specifieke	
plug-ins hierna niet meer goed werken, kun je de wijzigingen weer ongedaan maken. 
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Conclusie 
Hebben we je met dit handboek geholpen? Onze bedoeling is om je snel en gemakkelijk 
een goede basis voor WordPress mee te geven. We hopen dat dit is gelukt én dat je het 
natuurlijk leuk vindt om je eigen project van de grond te krijgen. 

Op ons eigen blog houden we je regelmatig op de hoogte van nieuwe WordPress functies 
en trends. Ook presenteren we daar regelmatig interessante en succesvolle websites, als 
inspiratie voor je eigen WordPress site. 

Tot slot vragen we ons af: hoe ziet jouw project eruit? We zijn erg benieuwd naar je 
feedback. Laat het ons weten via ons blog, op Facebook of op Twitter! 

Veel succes en vriendelijke groeten,

STRATO team 

https://www.strato.nl/blog/
https://www.strato.nl/blog/
https://www.facebook.com/STRATONL/
https://twitter.com/STRATO_NL
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Woordenlijst
.htaccess-bestand 

Het	.htaccess-bestand	(afkorting	voor	hypertext	access)	is	een	configuratiebestand	voor	
webservers. Je kunt het gebruiken om wachtwoordbeveiliging in te stellen voor bepaalde 
mappen of omleidingen naar andere domeinen. Dat laatste is belangrijk, bijvoorbeeld om 
de WordPress Multisite-functie te activeren. Het .htaccess-bestand wordt automatisch 
aangemaakt tijdens de installatie van WordPress. Je kunt het downloaden via een SFTP-
toegang en vervolgens wijzigen. 

Alt-tekst (alternatieve tekst)

Mensen met een visuele beperking gebruiken zogenaamde schermlezers om de inhoud 
van websites te lezen. Daarom moeten ingesloten afbeeldingen worden voorzien van 
korte beschrijvende teksten. Deze alt-teksten kunnen bestaan uit een paar kernwoorden 
of een beschrijvende zin. Met WordPress kun je voor elke afbeelding in de 
mediabibliotheek een alternatieve tekst invoeren (Afbeelding selecteren > rechterkant: 
Alternatieve tekst). 

Back-up 

Back-up is de Engelse term voor een veiligheidskopie voor gegevensbescherming. Als je 
regelmatig back-ups maakt, verklein je de kans op verlies van gegevens. De geback-upte 
inhoud kan dan worden teruggezet naar de toestand op het moment van de back-up. De 
gegevens van een website bestaan uit de inhoud van de webspace (inclusief WordPress 
bestanden en foto‘s) en de database-items (teksten). Om een volledige back-up uit te 
voeren, moet je dus de webspace en de database back-uppen. 

Berichten 

WordPress maakt onderscheid tussen de contenttypes pagina‘s en berichten. Pagina‘s zijn 
bedoeld voor inhoud die zelden of nooit verandert, zoals de pagina “Over ons“. Berichten 
zijn bedoeld voor alle andere huidige content (Berichten > Nieuw bericht). Deze berichten 
verschijnen automatisch op de startpagina als je ze publiceert. 

Blok 

De	WordPress	editor	definieert	elke	paragraaf,	afbeelding	of	video	als	een	blok.	 
Er zijn blokken voor opmaak, opmaakelementen, widgets en social media. Elk blok  
heeft zijn eigen menu om bijvoorbeeld kleuren, breedte en uitlijning aan te passen.  
Deze blokmenu‘s zie je zodra je een blok selecteert. De blokken bevinden zich in de 
blokkenbibliotheek. Die kun je op verschillende plaatsen oproepen door op het  
‘+’-symbool te klikken. Gebruik de zoekfunctie om snel het juiste blok te vinden. 
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Caching 

In WordPress wordt elke pagina door de server gegenereerd zodra die wordt opgeroepen. 
Dit betekent dat de verschillende vormen van content (afbeeldingen, teksten, lay-out) van 
de website in de kortst mogelijke tijd voor de bezoeker beschikbaar zijn. Zulke dynamische 
pagina‘s hebben het voordeel dat veranderingen onmiddellijk worden toegepast en 
getoond aan de bezoekers. Aan de andere kant kost deze techniek veel rekenkracht, 
vooral als veel bezoekers tegelijk de pagina oproepen. 

Bij caching blijven de pagina‘s die de server verstrekt, tijdelijk opgeslagen. Zulke complete 
pagina‘s hoeven dus alleen maar opnieuw verstuurd te worden, zonder dat de server ze 
opnieuw genereert. Daardoor laden pagina‘s merkbaar sneller als er grote aantallen 
bezoekers zijn. 

Categorie 

Categorieën worden gebruikt om je blog te structureren en te oriënteren. Ze worden vaak 
gelinkt in de navigatie van het blog en op berichtniveau, zodat bezoekers gemakkelijk 
soortgelijke berichten kunnen vinden. Daarom moet je elk bericht aan minstens één 
geschikte categorie toewijzen. 

Cross-site scripting 

Cross-site scripting (afkorting: XSS) draait om het invoegen van JavaScript-code in een 
invoervak van een website of toepassing. Zo kan die code ongemerkt worden uitgevoerd. 
Cross-site scripting wordt telkens weer gebruikt om beveiligingslekken in WordPress of 
plug-ins uit te buiten, bijvoorbeeld om beheerderstoegang te verkrijgen. Zo kon door een 
ernstig	beveiligingslek	in	WordPress	in	november	2014	kwaadaardige	code	worden	
geïnjecteerd via de commentaarvelden. Daarom is het belangrijk om WordPress en 
plug-ins altijd up-to-date te houden. 

Dashboard 

Direct na het inloggen kom je automatisch in het dashboard van WordPress. Op de 
startpagina van deze interface vind je informatie over je activiteiten, WordPress nieuws en 
tips om aan de slag te gaan. Je kunt beschikbare updates oproepen en uitvoeren via het 
menuonderdeel Updates. 

Domein 

Een domein is een uniek internetadres. Het bestaat uit een vrij te kiezen naam en een 
extensie, het zogenaamde topleveldomein (TLD). Voor https://kattenvereniging-limburg.nl 
is bijvoorbeeld ‘kattenvereniging-limburg‘ de naam en ‘.nl‘ de bijbehorende extensie. Veel 
aantrekkelijke domeinen met populaire extensies als .nl en .com zijn echter al bezet. 
Daarom	zijn	sinds	2013	geleidelijk	veel	nieuwe	TLD‘s	geïntroduceerd,	zoals	.photography,	
.amsterdam en .shop. 
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Firewall 

Een	firewall	is	software	die	een	computer	of	netwerk	kan	beschermen	tegen	
kwaadaardige	toegang.	Daartoe	controleert	de	firewall	elke	verbinding	om	te	zien	of	die	is	
toegestaan. Zo niet, wordt die verbinding geblokkeerd. De beheerder geeft in de regels 
aan welke toegangen zijn toegestaan. 

Flexibele modus 

Met de STRATO WordPress hostingpakketten heb je bij de installatie van WordPress de 
keuze	tussen	de	flexibele	en	veilige	modus.	Ben	je	vertrouwd	met	WordPress	en	wil	je	
handmatig	updates	installeren?	Neem	dan	de	flexibele	modus.	Dan	ben	je	volledig	zelf	
verantwoordelijk voor de veiligheid en actualiteit van je WordPress installatie. Let op: je 
kunt dan later niet naar de veilige modus overschakelen. 

Hostingpakket 

STRATO hostingpakketten omvatten bijna altijd een domein, webspace, database en 
talrijke technische voorzieningen. Dit voldoet ruimschoots aan de eisen voor het veilig 
functioneren van WordPress. Heb je geen tijd voor technische details en wil je gewoon aan 
de slag? Dan is STRATO WordPress Hosting Starter de juiste keuze voor jou. Met 
WordPress Hosting Basic beschik je bijvoorbeeld over een WordPress testomgeving. Wil je 
nóg meer? Dan is een upgrade geen probleem. In het pakket WordPress Hosting 
Advanced kun je bijvoorbeeld meerdere websites aanmaken. 

HTML-tags 

HTML-bestanden (Hypertext Markup Language) vormen de basis van alle websites. Ze 
geven aan hoe browsers verschillende elementen moeten weergeven: teksten, 
afbeeldingen, links en nog veel meer. Individuele elementen worden gemarkeerd door 
een begin- en een eind-tag tussen haakjes. Zo worden onder andere teksten opgemaakt. 
Om bijvoorbeeld een vetgedrukt woord te benadrukken, staat het woord tussen <strong> 
en </strong>. De WordPress editor voegt HTML-tags automatisch in via de tools in het 
blokmenu of via sneltoetsen. Wil je de code van een bericht of pagina zien? Dan schakel je 
van de visuele editor naar de code editor, via het menu met drie puntjes rechtsboven. 

Indexeren

Zoekmachines als Google moeten snel resultaten leveren. Daarom kunnen ze niet voor 
elke zoekopdracht live op internet zoeken. In plaats daarvan speuren zogenaamde 
crawlers (bots) voortdurend het internet af naar nieuwe en gewijzigde websites. 
Zoekmachines slaan deze informatie vervolgens op in de index of databases en werken 
die voortdurend bij. Zodra je pagina‘s geïndexeerd zijn, verschijnen ze in de 
zoekresultaten. Hoe beter de ranking, hoe hoger je in de zoekresultaten staat en hoe 
groter de kans dat bezoekers je vinden via de zoekmachine.
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Lazy loading 

Dit kun je letterlijk vertalen als ‘lui laden‘. Het is een webdesigntechniek waarbij bepaalde 
inhoud van een website pas wordt geladen na een actie van de gebruiker. Dit is vooral 
praktisch bij veel afbeeldingen en lange pagina‘s. De afbeeldingen worden dan niet 
allemaal tegelijk geladen, maar pas na het scrollen in het zichtbare gebied. Zo wordt de 
laadtijd verdeeld en subjectief als korter ervaren. 

Major releases 

Major releases zijn de belangrijkste versies van WordPress. Ze hebben maximaal één punt 
achter het versienummer, bijvoorbeeld 6.0 en 6.1. Major releases worden niet standaard 
automatisch geïnstalleerd. Je moet de update handmatig starten. Trouwens, omdat veel 
WordPress ontwikkelaars van jazz houden, krijgen grote releases de naam van populaire 
jazzmuzikanten. 

Malware 

Malware is een algemene term voor kwaadaardige software die ongewenste functies 
uitvoert op de geïnfecteerde webspace of computer. Hackers buiten kwetsbaarheden in 
browsers en webapplicaties uit om andere websites en computers te infecteren. Vaak zijn 
geïnfecteerde websites niet eens als zodanig herkenbaar. Zo vormen ze ook een gevaar 
voor hun bezoekers en andere websites. 

Masterwachtwoord 

Met het masterwachtwoord kun je alleen inloggen op de diensten van je pakket, 
bijvoorbeeld op de SFTP-toegang. Het is niet mogelijk om met dit masterwachtwoord 
toegang te krijgen tot de STRATO klantenlogin. Dit betekent dat je het masterwachtwoord 
zo nodig kunt doorgeven aan beheerders die jou helpen. Ze kunnen dan bijvoorbeeld 
géén contractinformatie of contactgegevens wijzigen. 

Mediatheek 

De WordPress mediabibliotheek (Media > Bibliotheek) bevat alle geüploade 
mediabestanden van je website: afbeeldingen, documenten, audiobestanden en video‘s. 
Dit centrale beheer is praktisch, omdat je bijvoorbeeld een afbeelding in zoveel berichten 
kunt gebruiken als je wilt. Je kunt de afbeelding zelfs bewerken: knippen, draaien, 
spiegelen en vergroten of verkleinen.



71STRATO | WordPress voor beginners

Meer-blok

Het meer-blok scheidt de teaser van het artikel. Op dit punt verschijnt een ‘lees meer‘-link 
of knop, die verwijst naar de volledige tekst. Zo kunnen je lezers gemakkelijk 
overschakelen	van	de	homepage	naar	het	desbetreffende	bericht.	Bovendien	maakt	dit	de	
startpagina overzichtelijker. Om de ‘meer‘-knop in te voegen, klik je in de editor op het 
‘+‘-symbool op de gewenste plaats en selecteer je vervolgens het bijbehorende blok in de 
blokbibliotheek. 

Minor releases 

Minor releases zijn de kleinere updates van WordPress. Je kunt ze herkennen aan het 
nummer	achter	de	hoofdversie,	bijvoorbeeld	6.0.1,	6.0.2	en	6.0.3.	Minor	releases	hebben	
betrekking op onderhoud, beveiliging en taalbestanden. Ze worden automatisch 
geïnstalleerd. Je krijgt per e-mail een melding als er een update is. 

Pagina‘s 

WordPress maakt onderscheid tussen de inhoudstypen ‘bericht‘ en ‘pagina‘. De laatste zijn 
bedoeld voor inhoud die niet zo vaak verandert, zoals de pagina ‘over ons‘. In de editor 
(Pagina‘s > Nieuwe pagina) voer je de kop en de hoofdtekst in. Na publicatie verschijnt de 
pagina niet meer op de startpagina. Om ervoor te zorgen dat je bezoekers hem toch 
kunnen vinden, moet je de pagina opnemen in een menu of er op een andere manier 
naar verwijzen. Je kunt in de instellingen (> Lezen) een statische pagina opgeven als 
startpagina. 

Schrijfbescherming 

Je kunt je WordPress bestanden en mappen tegen schrijven beveiligen om ze te 
beschermen tegen hackers en andere ongewenste toegang. Maar omdat WordPress 
bepaalde rechten vereist voor bijvoorbeeld updates en plug-in-installaties, moet je de 
bestandsrechten niet over de hele linie toewijzen. Ga bovendien niet te restrictief te werk. 
Met	STRATO	SiteGuard	kun	je	een	effectieve	individuele	schrijfbeveiliging	voor	je	
webspace creëren. 

SFTP 

SFTP (Secure File Transfer Protocol) is een netwerkprotocol om bestanden versleuteld uit 
te wisselen tussen server (webspace) en client (computer). Dankzij de uploadfunctie in de 
Mediabibliotheek heb je geen SFTP nodig voor het instellen en normaal functioneren van 
WordPress. Het protocol is vooral nuttig als je WordPress handmatig wilt installeren of 
afzonderlijke bestanden en mappen wilt aanpassen. Om verbinding te maken met je 
webspace heb je de toegangsgegevens en een FTP-programma nodig, zoals FileZilla. In 
onze FAQ lees je hoe je aan die toegangsgegevens komt. 
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Spam 

Spam omvat ongewenst commentaar of berichten die geen verband houden met de 
inhoud van het bericht en links bevatten naar dubieuze (of puur commerciële) websites. 
Vaak zijn ze ook in een andere taal geschreven. Met WordPress (> Reacties) kun je zulke 
commentaren markeren als spam en dan onherroepelijk verwijderen uit de spammap. 
Met de toenemende zichtbaarheid wordt je website ook het doelwit van zulke (meestal 
automatisch gegenereerde) reacties. Daarom moet je beslist een plug-in installeren die 
spam herkent en naar de spammap verplaatst (bijvoorbeeld Antispam Bee). 

SQL-injecties 

SQL is een veelgebruikte databasetaal. Met een SQL-injectie probeert een aanvaller 
SQL-code in de database te injecteren. Als hij succes heeft, kan hij in het ergste geval de 
controle over de website overnemen. Bij WordPress komen steeds weer SQL-injecties 
voor, vaak via ernstige beveiligingslekken in plug-ins. Om je installatie te beschermen, 
moet je zo weinig mogelijk plug-ins gebruiken, letten op betrouwbare aanbieders en altijd 
tijdig updates uitvoeren. 

SSH 

SSH is de afkorting voor ‘Secure Shell‘ en beschrijft een netwerkprotocol waarmee je een 
versleutelde verbinding met de server tot stand kunt brengen. Zo kunnen opdrachten 
worden uitgevoerd via de zogenaamde console. Hiervoor heb je een programma als 
PuTTY en je STRATO toegangsgegevens nodig. In de regel heb je geen SSH-toegang nodig 
om	WordPress	te	configureren.	

STRATO Backup Control 

Backup Control is een eenvoudig hulpmiddel voor het maken van back-ups van je 
webspace of de hele applicatie inclusief database-inhoud (STRATO Klantenlogin > 
Beveiliging > STRATO Back-upbeheer). Je hebt de beschikking over twee opslaglocaties: 
één voor een automatische en één voor een handmatige back-up. Backup Control is 
inbegrepen bij alle STRATO hostingpakketten. 

STRATO hostingpaketten 

STRATO	biedt	zowel	standaard	hostingpakketten	als	specifieke	WordPress	pakketten	aan.	
De	standaard	hostingpakketten	bieden	meer	flexibiliteit	omdat	je	naast	WordPress	ook	
andere applicaties kunt installeren en extra FTP-gebruikers kunt aanmaken. De WordPress 
pakketen zijn speciaal voor WordPress ontworpen en bieden extra features, zoals een 
testomgeving en een veiligheidsfeature. 
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STRATO SiteGuard 

Steeds weer maken hackers gebruik van schrijftoegang om bestanden op de webspace te 
manipuleren en malware te uploaden. Met de gratis tool STRATO SiteGuard kun je een 
algemene schrijfbeveiliging activeren en bepaalde mappen uitsluiten. Het bewaakt ook je 
webspace en informeert je per e-mail over toegang. Om verdere potentiële 
beveiligingsgaten te dichten, kun je ook SFTP- en SSH-diensten deactiveren. SiteGuard is 
inbegrepen in elk STRATO hostingpakket. Je vindt de tool in de STRATO klantenlogin onder 
Beveiliging > SiteGuard. 

Subdomein

Een subdomein is het deel van een domein dat gescheiden wordt door een punt  
voor de eigenlijke naam. Je kunt een subdomein gebruiken om bepaalde gebieden,  
zoals een blog of een fotogalerij, af te scheiden van de rest van de website. Voorbeeld:  
blog.kattenvereniging-limburg.nl. 

Je kunt eenvoudig subdomeinen aanmaken via de STRATO klantenlogin (Domeinen > 
Domeinbeheer > tandwieltje > Subdomein toevoegen). 

Teaser

De term ‘teaser‘ wordt vaak gebruikt in marketing en journalistiek. Het verwijst naar een 
korte, ‘verleidelijke‘ tekst die bedoeld is om de nieuwsgierigheid van de lezer te wekken en 
hem aan te moedigen verder te lezen. Teasers zijn meestal twee tot drie zinnen lang en 
verschijnen op de start- en archiefpagina‘s. Om naar het volledige artikel te linken, plaats 
je in WordPress het blokje ‘meer‘ na de teaser. 

Thema 

Lay-outsjablonen worden in WordPress thema‘s genoemd. Na de installatie van 
WordPress is automatisch het huidige standaardthema actief. Je kunt nog meer thema‘s 
uploaden via Weergave > Thema‘s > Nieuwe toevoegen en ze dan activeren. Je krijgt 
bovendien	automatisch	toegang	tot	de	officiële	themabibliotheek	of	repository.	Deze	
biedt talloze gratis thema‘s. Betaalde thema‘s bieden vaak meer functies en professionele 
ondersteuning. Zoek bij het kiezen van een thema naar een gerenommeerde aanbieder, 
de datum van de laatste update en feedback van de community. Belangrijk: houd voor 
noodgevallen altijd een extra thema geïnstalleerd naast het actieve thema.

Toegankelijk webdesign 

Bij webdesign betekent toegankelijkheid dat de inhoud voor alle gebruikers toegankelijk 
is. Om mensen met een visuele beperking onbeperkt toegang te geven, moet aan 
verschillende voorwaarden worden voldaan. Daartoe behoren alt-teksten, voldoende 
grote lettertypen, zinvolle linkteksten en gestructureerde HTML. Dit laatste betekent 
bijvoorbeeld	dat	je	(tussen)koppen	in	de	editor	moet	voorzien	van	de	HTML-elementen	H1	
(groot) tot en met H6 (klein). 
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URL 

Een URL (Uniform Resource Locator) wordt in de volksmond ook wel een internetadres 
genoemd.	Het	verwijst	meestal	naar	een	specifiek	pad	of	een	specifieke	map	van	een	
website. Een URL bestaat uit verschillende onderdelen zoals het protocol (https), het 
domein, het topleveldomein en eventueel een directory. Als we bijvoorbeeld op ons 
kattenblog een subpagina voor Kitty hebben gemaakt, kan de URL er als volgt uitzien: 
https://kattenvereniging-limburg.nl/kitty. 

Veilige modus 

Bij het installeren van de STRATO WordPress hostingpakketten kun je kiezen tussen een 
flexibele	en	veilige	modus.	Heb	je	geen	ervaring	hebt	met	WordPress	en	wil	je	gewoon	
beginnen? Dan is de veilige modus de beste keuze. In deze modus krijg je automatisch de 
belangrijke WordPress updates. Wil je zelf de timing van de updates bepalen? Dan kun je 
altijd	overschakelen	naar	de	flexibele	modus.	Maar	let	op:	terugschakelen	naar	de	veilige	
modus is dan niet meer mogelijk. 

Webspace 

De webspace is als het ware de harde schijf voor je website. Alles wat je uploadt naar 
WordPress of via SFTP wordt hier opgeslagen: WordPress bestanden, thema‘s, plug-ins, 
afbeeldingen, PDF-documenten, enzovoort. De grootte van de webspace hangt af van het 
pakket. 

Website-apps

Website-apps is een gedeelte in de STRATO klantenlogin met een installatiewizard voor 
verschillende (gratis) open-source-toepassingen zoals blogs, shops en 
contentmanagementsystemen. In een paar stappen kun je de toepassingen binnen je 
hostingpakket installeren zonder enige technische voorkennis. De installatiehulp zet de 
software automatisch op je webspace, maakt een database aan en koppelt die aan de 
toepassing. Website-apps is inbegrepen in alle reguliere STRATO hostingpakketten. Je start 
het via de STRATO klantenlogin (> Website-apps).   
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